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Important Notice 

This guide is subject to the following conditions and restrictions: 
 

This User’s Guide provides documentation for the PowerTerm Series of products. Your 
specific PowerTerm product might include only a portion of the features documented in this 
Guide. 

• 

• 

• 

• 

• 

• 

The proprietary information belonging to Ericom® Software Ltd. is supplied solely for the 
purpose of assisting explicitly and properly authorized users of PowerTerm®. 
No part of its contents may be used for any other purpose, disclosed to any person or firm, or 
reproduced by any means, electronic and mechanical, without the express prior written 
permission of Ericom® Software Ltd. 
The text and graphics are for the purpose of illustration and reference only. The specifications 
on which they are based are subject to change without notice. 
The software describe in this document is furnished under a license agreement. The software 
may be used or copied only in accordance with the terms of that agreement. 
Information in this document is subject to change without notice. Corporate and individual 
names and data used in examples herein are fictitious unless otherwise noted. 

 
Copyright© 2003 Ericom® Software Ltd. 
 
Ericom® and PowerTerm® are registered trademarks of Ericom® Software Ltd., which may be 
registered in certain jurisdictions 
Other company and brand, product and service names are trademarks or registered trademarks of 
their respective holders. 
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About this Guide 

PowerTerm is a fully functional terminal emulator for Microsoft Windows, Linux, Mac OS X, 
and Solaris. 
This Guide assumes that you are familiar with basic windowing system conventions (file 
transferring, copy/paste functions, etc.) and the operation of the terminal you intend to emulate. 
 
The PowerTerm User’s Guide is comprised of the following chapters: 
 
Chapter 1, Introduction to PowerTerm, presents PowerTerm and describes its main features. It 
also provides a quick guide to working with PowerTerm. 
Chapter 2, The PowerTerm Window, provides an overview of the PowerTerm window and its 
components. 
Chapter 3, Using PowerTerm, provides step-by-step instructions for using PowerTerm. 
Chapter 4, Scripts, describes the use of the Power Script Language (PSL). For a more detailed 
description of each PSL command, see the PowerTerm online help and the “PowerTerm Power 
Script Language, Programmer’s Reference”, available in pdf format. 
Chapter 5, Menu Reference, describes each of the PowerTerm menu options. 
Chapter 6, Introduction to the PowerTerm FTP Client, presents PowerTerm FTP Client and 
describes its main features. It also provides a quick step-by-step guide for working with 
PowerTerm FTP Client as well as an overview of the PowerTerm FTP Client window and its 
components. 
Chapter 7, Working with the PowerTerm FTP Client, describes how to define connection 
parameters as well as the procedure to connect to an FTP site. It also describes how to display 
connection information. 
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• 
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• 
• 
• 

 
  

 
Chapter 

Introduction to PowerTerm 

This chapter presents PowerTerm and its main features. A quick guide to the PowerTerm is also 
provided. It describes the basic steps for users who are familiar with accessing remote terminals. 
 
This chapter includes the following topics: 
 

What is PowerTerm? 
PowerTerm Features 
System Requirements 
PowerTerm Setup 
A Quick Guide Through PowerTerm 
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What is PowerTerm? 

PowerTerm is a fully functional emulation for Microsoft Windows, Linux, Mac, and Solaris 
operating systems. It emulates various terminal types, including UNIX, OpenVMS and IBM. 
PowerTerm enables you to connect to a single host or multiple hosts via both network and remote 
connections. 
 
PowerTerm provides two main features to enable the PC to act and feel like a real host terminal: 
 

Terminal display emulation • 

• 

• 

• 

• 

PowerTerm emulates the exact display of the chosen terminal. It presents host applications 
exactly as they would appear on the terminal. Once the PC connects to a host computer, all 
host operations can be performed as if the PC is an actual terminal. 
Terminal keyboard emulation 
PowerTerm enables you to emulate the selected terminal’s keyboard by mapping the PC keys 
to match the host keys. Keyboard mapping definitions are stored in a .ptk file. 

 
PowerTerm also provides various options to customize and optimize the working environment 
such as: 
 

Power Pad (Windows edition only) 
A programmable floating keypad. 
Soft buttons  
Programmable buttons located at the bottom of the PowerTerm window.  
Power Script Language (PSL) 
A special programming language,  which enables you to create scripts for automating tasks. 
For example, you can create a PSL script for automatic login. Scripts can be used at startup of 
PowerTerm, or can be utilized anytime during a PowerTerm session. PSL is intended for 
users with scripting or programming skills. PSL commands can also be assigned to the Power 
Pad and the Soft buttons to enable additional functions with a click of the mouse. 

 
PowerTerm enables you to use the standard Microsoft DDE mechanism to communicate with 
other Windows applications as a DDE client or DDE server application. 
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PowerTerm Features  

Compact, light and high performance program. • 

• 

• 32-bit support for Windows 95/98/2000/NT/XP, Linux, Mac OS X, and Solaris. 
• File transfer for Xmodem, Ymodem, Zmodem, Kermit, Ascii, Binary and IND$FILE. 
• Support for TCP/IP WinSock, DECnet (CTERM) and LAT. 
• Support for RS-232 (both direct and via modem), PPP/SLIP, SNA and APPC connections. 
• Support for Ethernet and Token ring networks. 
• Script recording for automation of tasks with PowerTerm Power Script Language (PSL). 
• String functions, including sub-string, index and concatenation. 
• Enables you to save parameters for all sessions. 
• High-level API enables access from other environments, such as C++, Visual Basic and 

Power Builder. It also supports EHLLAPI. 
• Support for most Western and Eastern European languages. 
• Modem dialing. 
• Multi-session capabilities. 
• User programmable Soft buttons. 
• Control of color selection and screen attributes. 
• Support for printing including Auto Print mode and Slave Printing, Advanced Printing 

capabilities: including TN5250 host print transform, specifying the orientation of the printed 
output for non-graphic printing, setting values for CPI/LPI/FONT parameters, printer rows 
and columns. 

• Support for Kermit get command. 
• Floating Power Pad with programmable buttons. 

DDE communication for client or server. 
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System Requirements 

To run PowerTerm you need: 
 

MS Windows version 95 or higher. • 
• 
• 
• 

386 data processor or higher. 
Connection to a host computer. 
9.1 MB free space on your hard disk. 
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PowerTerm Setup 

To enable PC-host interaction, you need to define two sets of parameters:  
 

Terminal parameters  • 
• Communication parameters 
 
These are both saved in a Terminal setup file where the default is called ptdef.pts. 
 
Setup file extensions are: 
 
• pts for the Terminal setup file.  
• ptc for the Communication setup file. 
• ptk for the Keyboard definitions file. 
 
PowerTerm provides the option to work with a single host connection or multiple connections. 
You can create different setup files for working with each connection to enable each user a 
customized working environment. 

Working with a Single Terminal Connection 

If you only need to connect to a single host connection, you should use the default terminal setup 
and communication file. PowerTerm automatically uses the parameters in the setup file to start 
the system. 

Working with Multiple Terminal Connections 

If you are working with multiple terminal connections, you may need to use a different setup file 
for each connection. To create a setup file, you first need to define the terminal setup and 
communication parameters, and then save these parameters to a terminal setup file. For more 
information about setup files, see Chapter 3: “Using PowerTerm”. 
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A Quick Guide Through PowerTerm 

The following workflow provides a quick guide for using PowerTerm: 
 
 
Each of the steps is explained on the pages that follow. For a more detailed description of these 
steps, see PowerTerm workflow in Chapter 3: “Using PowerTerm”. 

Step 1: Start PowerTerm 

• Start PowerTerm by clicking the PowerTerm icon in the Ericom PowerTerm group. The 
PowerTerm window opens. 

 
When PowerTerm is used for the first time, the PowerTerm window is automatically displayed 
together with the Connect dialog box. After the connection parameters have been defined, the 
Connect dialog box will be displayed according to your selected option. For more information on 
defining connection preferences, see Step 3: “Defining Settings for Terminal Emulation, 
Preferences Property page”. 
 
PowerTerm opens with the default terminal setup file. You can also open PowerTerm using a 
customized setup file, or script file. 
 
The most important feature of the PowerTerm window is its work area, which emulates a host 
terminal screen by displaying data entered on your terminal and data received from the host. 

Step 2: Select a Terminal Emulation 

You can either select a terminal for the current session or open a previously defined terminal 
setup file. 
 

¾ 

1 
2 
3 

4 

5 
6 

1. 
2. 

¾ 

To select terminal settings: 

Select the Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Emulation tab. 
Click one of the Terminal Types. The emulation type that you select changes the 
number of setup tabs and, for IBM emulations the PowerTerm window display. 
Define terminal settings by clicking the relevant Property page tab and define setup 
parameters.  
Click OK. 
Save the settings by clicking File | Save Terminal Setup. 
or, 

Select File | Save Terminal Setup As. 
Specify a setup file name and click OK.  

The file is saved. 
 

To open a previously defined Terminal setup file: 
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1 
2 

1 
2 
3 

¾ 

1 
2 

1 
2 

• 

• 

Select File | Open Terminal Setup. The Open File dialog box appears. 
Select a setup file and click Open. 

or, 
Select Communication | Connect. The Connect dialog box appears. 
Click Setups. The Setup dialog box appears. 
Type a setup file name or click the browse button. The Select File dialog box appears. 
Select a setup file. 
 

Step 3: Connect to a Host 

After you have selected a terminal emulation, you can connect to a host. Before connecting to a 
host, you need to define communication parameters for the current session, or select a previously 
saved session from the session list. To define communication parameters for a current session, 
select a session type and the session parameters. PowerTerm also provides an option to run a 
script file before you connect to a host, or select a Terminal setup file to define terminal settings. 
 
To connect to a host: 

Select Communication | Connect. The Connect dialog box appears. 
Define communication parameters. 
or 
Select a session with previously defined connection parameters from the Sessions List. 
Click Connect. A connection is established to a host computer. 

Step 4: Work with a Host 

PowerTerm provides the following options for working with a host: 
 
Transferring files PowerTerm enables you to transfer files to and from a host. 

For non-IBM terminal emulations PowerTerm transfers 
files in Kermit, Xmodem, Ymodem, Zmodem, ASCII, 
or Binary mode. 
For IBM terminal emulations PowerTerm enables you to 
select CMS, TSO, or CICS as a Mainframe working 
environment. 

 
Printing files PowerTerm enables you to define print parameters, and print 

the terminal screen or data transferred from the host 
application. 
 

Step 5: Exit PowerTerm 

PowerTerm provides different options when exiting PowerTerm. You can end a session 
automatically or be prompted with a confirmation message prior to closing a session. If you have 
changed terminal settings, PowerTerm displays a warning message asking if you want to update 
the Terminal settings file. The message will point to the name of the setup file currently loaded 
(ptdef.pts, if you used the default). 
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¾ 

• 

To exit PowerTerm: 

Select File | Exit. The PowerTerm window closes. 
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Chapter 2:  

 

Chapter 

 

The PowerTerm Work Area 

This chapter provides an overview of the PowerTerm window and its components. The 
PowerTerm window contains menu and toolbar options that provide access to most PowerTerm 
functions. Right-clicking the relevant PowerTerm object can access even more PowerTerm 
functions. 
 
The most important feature of the PowerTerm window is its work area, which emulates a host 
terminal screen by displaying data entered on your terminal, and data received from the host.  
 
This chapter also includes a section describing how to select text in PowerTerm. 
 
This chapter describes the following topics: 
 

The PowerTerm Window • 
• 
• 
• 
• 
• 

Menu Bar 
Toolbar 
Hot Keys 
Manipulating Desktop Components 
Selecting Text 
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The PowerTerm Window 

 
 
 
The PowerTerm window consists of the following components: 
 
Control Menu Box Provides standard Windows commands and enables you to 

redisplay the Menu bar. 
 

Title Bar Displays the application name. During a communication 
session, the ID type and/or the host name is displayed next to 
the application name. For example, (A) PowerTerm. 
 

Menu Bar Contains dropdown menus, which enable the user to perform 
most PowerTerm operations.  
 

Toolbar Contains buttons, which can be used as shortcuts to access 
frequently used menu commands.  
 

Work Area Displays the data entered on the PC terminal or received from 
the host. During an emulation session, this work area emulates 
a terminal display. For IBM terminal types, the work area is 
displayed in black. 
 

History Scroll Bar Enables you to scroll up and down through the PowerTerm 
window to view previously displayed data. Displayed by 
default.  
For non-IBM emulations only. 
 

Emulator Type Displays the current terminal emulation type selected from the 
Emulation tab in the Terminal Setup dialog box. 
 

Cursor Position Counter Displays the current line and column position of the text cursor 
in the work area. 
 

Caps Indicates whether the keyboard is in Caps lock mode. 
 

Hold Indicates whether the screen is in hold or frozen mode. 
 

Status Indicator –  
On Line,  
Off Line, Printer,  
Auto Prt 

• 

• 

• 

The status indicator reads On Line when communication is 
established. 
The indicator reads Printer when data is transmitted with a 
printing request to the slave printer. The color of the 
indicator is the same as when PowerTerm is in On Line 
mode. For example, the printer will appear in red if the 
system was On Line when the printing request arrived.  
The date is sent to the screen and printer, and the indicator 
reads Auto Prt, when the terminal is in Automatic 
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Printing mode. 
 

Soft Buttons Area Contains a series of buttons that you can program to execute 
specific script commands.  
 

Macro/Message Display Area Displays system messages, or a script sequence as you type it in 
the work area. 
 

Minimize button Closes the window, but not PowerTerm.  
• Click the PowerTerm button appearing in the Taskbar to 

reopen the PowerTerm window. 
 

Maximize button Enlarges the window so that it fills the entire screen. The button 
is then replaced with the Restore button. This button is used to 
restore the window to its previous size. 
 

Window Border and Corners Changes the size of the window. The characters that appear in 
the work area are scaled up or down so that all the information 
always remains in view. 
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Menu Bar 

The PowerTerm Menu bar displays the main PowerTerm functions in dropdown menus.  
The following is a brief description of each PowerTerm menu and the functions that it can 
perform.  
 
File Menu Provides options to create, save and restore a terminal setup file 

as well as to set printing parameters, print the screen and open a 
new instance of the PowerTerm window.  
The File menu also enables you to save your keyboard and 
Power Pad settings, and open them at a later date. 
 

Edit Menu Provides options to select, clear and reverse text in the 
PowerTerm window as well as delete the contents of the history 
buffer.  
The Edit menu also provides standard windowing operating 
system commands (copy and paste), in addition to commands 
that enable you to copy data to a file or to the Clipboard. 
 

Terminal Menu Provides options to define and reset connection (terminal and 
communication) parameters, set the system to be online or 
offline, and freeze or unfreeze the screen.  
You can also select the fonts to be displayed in the PowerTerm 
window. 
 

Communication Menu Provides options to define and modify the communication 
(session) parameters, and to disconnect a PowerTerm session.  
The Communication menu also provides options for file 
transfer as well as to select a modem, add customized modem 
definitions and edit the initialization string. 
 

Sessions menu Provides easy access to multiple sessions of PowerTerm. An 
alternative to navigating with the Toolbar buttons. 
 

Options Menu Provides options to display and edit the keyboard mapping, and 
define the Power Pad display.  
The Options menu also enables you to capture session data in a 
log file for debugging purposes and provides options to hide or 
show PowerTerm window components. 
 

Script Menu Provides options to record, edit and run a script as well as open 
and save scripts. 
 

Help Menu Provides options for accessing the PowerTerm online helps and 
product information. 
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Working with Menus and Commands 

You can select menus and commands by: 
 

Using a mouse • 
• 
• 

¾ 

1 
2 

¾ 

1 
2 
3 
4 

¾ 

1 

2 

Using direction keys 
Typing a letter 

 
To select a menu item using the mouse: 

Click the desired menu on the menu bar. The menu drops down. 
Click the desired menu item.  

N
 

OTE After clicking the name of a menu or the menu bar, you can drag the mouse 
to the right, left or up and down to move to other options. 
 

To select a menu item using direction keys: 

Press the <Alt> key to access the menu bar. The far left menu is highlighted. 
Use the direction (arrow) keys to move the highlighting bar to select a menu. 
Press the down arrow to open the menu. 
Use the up and down arrows to highlight the command that you want and press <Enter>. 

 
To select a menu or menu item by typing a letter: 

Menus, menu items and commands have an underline character.  
Hold down the <Alt> key and type the underlined letter of the desired menu. For 
example, hold down the <Alt> key and type the letter <F> to open the File menu.  
Type the desired menu item’s underlined character. 
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Toolbar 

The PowerTerm Toolbar contains buttons, which provide shortcuts to frequently used menu 
options. 
 

NOTE For IBM emulation types, the Toolbar consists of fewer options. 
 
 

The following is a brief description of each PowerTerm Toolbar button and its function: 
 
Hold Screen/Release Hold 

 

Freezes and unfreezes the PowerTerm window.  
The STOP button appears red when the PowerTerm window 
freezes and green when it unfreezes. 
Equivalent to Terminal | Hold Screen. 
 

Connect/Disconnect 

 

Enables you to define session communication parameters and 
connect to the host computer.  
Disconnects an open session. 
Equivalent to Communication | Connect (Disconnect).  
 

Copy To Clipboard 

 

Copies selected data displayed in the PowerTerm work area to 
the Clipboard.  
Equivalent to Edit | Copy. 
 

Paste From Clipboard 

 
 

Pastes data from the Clipboard to the host application.  
Equivalent to Edit | Paste. 
 

Print  

 
 

Prints selected text or the entire contents of the work area.  
Equivalent to File | Print Screen. 
 

Start/Stop Auto Print  

 
 

Starts/Stops printing incoming data as it is displayed on the 
screen. Equivalent to File | Start Auto Print (Stop Printing).  
 

Dial  

 

Enables you to dial a specific telephone number for COM type 
communication.  
Equivalent to Communication | Utilities | Dial. 
 

Start/Stop Script Recording  

 
 

Starts/Stops recording manual operations that you perform, in 
script form.  
Equivalent to Script | Start (Stop) Script Recording. 
  

Change to 80 Columns  

 
 

Specifies an 80-column display for the PowerTerm work area.  
Equivalent to Terminal | Setup | Display | Dimensions 80 
Columns. 
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Change to 132 Columns  

 
 

Specifies a 132-column display for the PowerTerm work area. 
Equivalent to Terminal | Setup | Display | Dimensions 132 
Columns. 
 

Terminal Setup  

 
 

Displays the Terminal Setup dialog box in which you can 
define terminal setup parameters.  
Equivalent to Terminal | Setup. 
 

Keyboard Mapping  

 
 

Opens the Keyboard Mapping dialog box in which you can 
map PC keys to host keys.  
Equivalent to Options | Keyboard Map. 
 

Show/Hide Power Pad  

 
 

Displays/Closes the Power Pad dialog box.  
Equivalent to Options | Show (Hide) Power Pad. 
 

Help Contents  

 
 

Displays the PowerTerm online help.  
Equivalent to Help | Contents. 
 

New Terminal Window  

 
 

Opens a new instance of the PowerTerm window. This option 
enables you to conduct several sessions concurrently.  
Equivalent to File | New Terminal Window. 
 

Session  

 
 

Displays an icon for each additional session of PowerTerm. 
 

 

¾ 

• 

To display a description of what each button does: 

Place your mouse cursor over a tool to display the tool tip. 
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Hot Keys 

Hot Keys are keyboard keys that you can press instead of selecting menu commands. These Hot 
Keys refer to your standard PC keyboard keys, before they are mapped to terminal keys. Once 
Hot Keys are mapped, they loose their original function and reflect the newly mapped terminal 
key. For example, if you map <Alt F4> to the <Backspace> key on the terminal keyboard, it 
performs the function of a <Backspace> key. 
 
The following table lists the default PowerTerm Hot Keys: 
 
Alt F4 Exit 

 
Alt F6 Open new terminal window 

 
Alt F9 Activate script 

 
Ctrl + Alt F9 Start/Stop recording script 

 
Alt F10 Select screen 

 
Alt F11 Clear screen 

 
Alt F12 Reverse screen 

 
Scroll Lock Hold screen 

 
Pause Change the cursor shape 

 
Ctrl Up Arrow Scroll up one line 

 
Ctrl Down Arrow Scroll down one line 

 
Ctrl Home Scroll to beginning of the history buffer 

 
Ctrl End Scroll to end of the history buffer 

 
Ctrl Page Up Scroll up one page 

 
Ctrl Page Down Scroll down one page 

 
Shift + Ctrl + X Switch focus to session X 

X is the session letter (A…Z) displayed in the PowerTerm 
window Title bar. 
 

Ctrl + Spacebar Switch to the next active session 
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Manipulating Desktop Components 

PowerTerm enables you to customize the PowerTerm window by displaying or hiding desktop 
components and changing the display colors for different text attributes. The color attributes 
change according to the emulation type you have selected. 
 

¾ 

• 
• 

¾ 

• 
• 

¾ 

• 
• 

¾ 

• 
• 

¾ 

• 
• 

¾ 

To show/hide the Menu bar: 

Select Options | Hide Menu. This removes the menu bar altogether. 
Click the Control Menu box, and then select Restore Menu, to restore the Menu bar. 

 
To show/hide the Soft buttons: 

Select Options | Hide Buttons. The menu option becomes Show Buttons. 
Select again to redisplay the Soft buttons bar. 

 
To show/hide the Status bar: 

Select Options | Hide Status Bar. The menu option becomes Show Status Bar. 
Select again to redisplay the Status bar. 

 
To show/hide the Toolbar: 

Select Options | Hide Tool Bar. The menu option becomes Show Tool Bar.  
Select again to redisplay the Toolbar. 

 
To show/hide the Power Pad: 

Select Options | Show Power Pad. The menu option becomes Hide Power Pad.  
Select again to hide the Power Pad. 

 
To show/hide the History Scroll bar: 

N
 

OTE This option is only available for non-IBM emulations. 
 
 

1 
2 
3 
4 

• 

¾ 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Display tab. The Display Property page is displayed. 
Select History Scroll Bar in the General section. 
Click OK. The PowerTerm window is redisplayed with the history scroll bar displayed. 

 
Clear History Scroll Bar to remove the history scroll bar from the PowerTerm window. 

 
 
To change the display color of the PowerTerm window: 

The color for the Normal attribute determines the color of the entire work area. The box above 
the Select Attribute parameter shows the result of your selections.  
For non-IBM emulations, the Select Attribute of the entire screen is generally Normal.  
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¾ 
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Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Colors tab. The Colors Property page is displayed. 
Click the attribute for which you want to define foreground and background colors.  

In the Text area, click the color that you want to apply to the text (foreground) of the 
display. 
In the Background area, click the color that will apply to the background for the text. 

Click OK. The PowerTerm window displays the selected colors. 
 
To disable/enable underline: 

You can choose whether to display data with or without the underline, for data received from the 
host with the underline attribute. 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Colors tab. The Colors Property page is displayed. 
Select/Clear Enable Underline as desired. 

 
To disable/enable blink: 

You can choose whether to enable blinking of data, for data from the host with the blinking 
attribute. 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Colors tab. The Colors Property page is displayed. 
Select/Clear Enable Blinking as desired. 

 
To disable/enable host colors: 

You can choose whether to work with the host colors or with your own (PC) color scheme. 
Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Colors tab. The Colors Property page is displayed. 
Select/Clear Disable Host Colors as desired.  
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Selecting Text 

You can select text in the work area using the mouse. The following are descriptions of specific 
text selection techniques that you may find useful in different emulations. 
 

¾ 

• 
• 

¾ 

1 
2 

1 
2 

¾ 
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2 

¾ 

1 
2 

1 
2 
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¾ 

• 

To select a word: 

Click a word to select it.  
Press <Ctrl> and click a word to select it and any punctuation marks or other symbols, up to 
the first space that follows them. 

 

NOTE If the Automatic Copy option in the Edit menu is activated (default), 
selecting text also copies the selection to the Clipboard. 
 

To select a block: 

A block is any section of the work area. 
For VT emulations: 

Point to one corner of the block. 
Press <Ctrl> and drag the mouse to the opposite corner of the block. 

 
For 3270 and 5250 emulations: 

Point to one corner of the block. 
Drag the mouse to the opposite corner of the block. 

 
To select full lines: 

Point anywhere in a line. 
Press <Shift> and drag the mouse, down or up, to the last line you want to include in the 
selection. 

 
To select a string: 

For VT emulations:  
Point to the first character that you want to include in the selection. 
Drag the mouse to the last character that you want to include in the selection and release 
the mouse button. 

 
For 5250 and 3270 emulations:  

Point to the first character that you want to include in the selection. 
Hold down the <Ctrl> key and drag the mouse to the last character that you want to 
include in the selection. 
Release the mouse button. 

 
To select the entire screen: 

Select Edit | Select Screen. The whole work area is selected. 
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¾ 

• 

¾ 

• 

To select a menu entry: 

For VT emulations only. 
 

Double-click a word and press <Enter>. The word is sent to the host followed by an <Enter> 
signal. For example, if the emulation screen displays an application menu residing on the 
host, click a menu entry to activate the program that the menu entry represents. 

 
To activate light pen support: 

NOTE For 3270 emulations only. 
 
 

 
Double-clicking on the screen is equivalent to touching it with a light pen. 
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Using PowerTerm 

Chapter 

 

This chapter provides step-by-step instructions for using PowerTerm and provides a detailed 
explanation of each step. 

N
 

OTE If you are familiar with accessing remote terminals, you may want to 
follow the procedure outlined in A Quick Guide through PowerTerm. 
 
 

This chapter consists of the following topics: 
 
Step 1: Starting PowerTerm 
Step 2: Setting up your Working Environment 
Step 3: Defining Settings for Terminal Emulation 
Step 4: Defining Modem and Communication Settings 
Step 5: Saving the Terminal Setup File 
Step 6: Connecting to a Host 
Step 7: Working with the Host 
Step 8: Ending a PowerTerm Session 
Step 9: Exiting PowerTerm 
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Step 1: Starting PowerTerm 

When PowerTerm is used for the first time, the PowerTerm window is automatically displayed 
together with the Connect dialog box. After the connection parameters have been defined, the 
Connect dialog box will be displayed according to y our selected option. For more information 
on defining connection preferences, see Step 3: “Defining Settings for Terminal Emulation, 
Preferences Property page”. 
 
PowerTerm opens with the default terminal setup file. You can also open PowerTerm using a 
customized setup file, or a script file. 
 

¾ 

1 
2 

• 

• 

¾ 

• 

¾ 

• 

To start PowerTerm: 

Click the Start button in the Task bar. 
Select Programs | Ericom Software | PowerTerm | PowerTerm. The PowerTerm 
window opens. 

Starting PowerTerm Using a Setup File 

PowerTerm can be started using a default or customized setup file. A setup file contains both 
communication session parameters and terminal setup parameters. It is in text format and can be 
edited using a text editor. 
 

The Default Setup file, called ptdef.pts, is used with single host connections. When you 
open PowerTerm, it automatically uses this file to initiate terminal setup and connection 
parameters. 
A customized setup file is used with multiple host connections and you want to start 
PowerTerm with predefined communication and terminal setup parameters for a specific 
connection. This can be done by using a command or creating a Windows shortcut. Before 
you create a shortcut to a setup file, you first need to create and save the setup file in 
PowerTerm. For more information about how to create and save a setup file, see Steps 3 - 5 
in this chapter. 

N
 

OTE You can also select and open a terminal setup file during a PowerTerm 
session. For more information, see Step 6: “Connecting to a Host”. 
 
 

To start PowerTerm with a customized setup file: 

Double-click the PowerTerm shortcut icon on your desktop or access it from the Start menu. 
Your session starts automatically with the predefined parameters. 

 
To use a setup file during a PowerTerm session: 

A terminal setup file can also be opened during a PowerTerm session to run a session using 
predefined terminal setup and communication parameters. There are two options to use a setup 
file: 

Select File | Open Terminal Setup. The Open File dialog box appears in which you can 
select a setup file. For more information, see Step 5: “Saving the Terminal Setup File”. 
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Select Communication | Connect. The Connect dialog box appears in which you can 
specify the name of the setup file to be run before communication is established. For more 
information, see Step 4: “Defining Modem and Communication Settings”. 

• 

¾ 

1 
2 
3 
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Starting PowerTerm Using a Script 

You can also launch PowerTerm and run a script immediately upon launching. Scripts are created 
with Power Script Language (PSL) and enable you to automate tasks. For example, you can use a 
script to automatically connect to a specific host.  

Starting PowerTerm with Auto Connect 

The Auto Connect option enables you to automatically connect to a specific terminal using the 
parameters in the default setup file. 
 
To access the Auto Connect option: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Preferences tab. The Preferences Property page is displayed.  
Select Auto Connect. 
Click OK. 

 
For more information about this option, see Preferences Property page in Step 3: “Defining 
Settings for Terminal Emulation”. 
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Step 2: Setting Up your Working 
Environment 

This section provides a description of the basic operations that may be performed to set up and 
optimize the PowerTerm working environment for your usage. You can customize the 
PowerTerm window to show or hide window components and change the display of the window. 
These options are all described in the Manipulating desktop components section of Chapter 2  
“The PowerTerm Window”. 
 
PowerTerm enables you to emulate a host keyboard by assigning (mapping) PC keys to host keys. 
It furthermore provides two features, the Power Pad and Soft buttons, which enable you to 
automate commands as well as to save your keyboard and/or Power Pad settings in separate files 
and open them at a later date. 
 

NOTE Changes made to either feature will not affect the others. 
 
 

To set up the PowerTerm work environment: 
 

Mapping the PC Keyboard • 
• 
• 
• 
• 
• 

¾ 

1 
2 

¾ 

1 
2 

Saving and Opening Keyboard Mapping Settings 
Programming the Power Pad 
Saving and Opening your Power Pad Settings 
Programming Soft buttons 
Selecting Fonts 

Mapping the PC Keyboard 

PowerTerm enables you to map PC keys to host keys in order to emulate the host terminal 
keyboard. The keyboard mapping definitions are stored in a file with the same name as the 
current terminal setup file, with the extension .ptk. For example, the default keyboard mapping 
definitions are stored in a file called ptdef.ptk. 
 
To view the default keyboard mapping: 

Select Options | Keyboard Map. The Keyboard Mapping dialog box appears. 
Slide the mouse pointer over the different keys. The bottom line of the dialog box shows 
you the corresponding PC and terminal keys. For example, if you point to the “t” key of 
the VT Keyboard, you see that the corresponding PC key is “T”. 

 
To map a PC key to a host key: 

Select Options | Keyboard Map. The Keyboard Mapping dialog box appears. 
Drag a key from the upper terminal keyboard to a PC key on the lower keyboard. 
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Click the <Shift> or <Control> keys on the terminal keyboard to display additional key 
functions. For example, if you click the <Shift> key, the alphabet keys on the terminal 
keyboard are displayed in upper case. You can then map (drag) these keys to your PC 
keyboard keys. 

• 

¾ 
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2 
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• 

• 

¾ 

• 

¾ 

• 

• 

¾ 

• 

¾ 

• 

¾ 

1 

 
To assign a script command to a PC key: 

Select Options | Keyboard Map. The Keyboard Mapping dialog box appears. 
Right-click a key on the PC keyboard that you want to assign a command and select 
Enter Script Commands. The PC Button dialog box appears. 
Enter the script command description and click OK. The PC key has now been assigned a 
script command. 

 
To map combinations of keys that include Alt, Ctrl and Shift: 

Click the <Alt>, <Ctrl> or <Shift> key (or any combination) on your PC keyboard. Then 
map keys by following the procedure described previously. 
Click the required <Alt>, <Ctrl> or <Shift> key (or any combination), to view the mapped 
key. 

 
To cancel a keyboard key definition: 

Drag the PC key definition that you want to cancel, in the Keyboard Mapping dialog box, to 
the wastebasket icon. This restores the default function of the PC key. 

 
To replace a PC key with another PC key: 

PowerTerm enables you to move the functionality of a mapped PC key to another PC key. For 
example, you can drag the F6 key on the PC keyboard to the spacebar on the PC keyboard to give 
it F6 functionality. 

Drag the desired PC key, in the Keyboard Mapping dialog box, onto the PC key that it will 
replace. The functionality of the PC key has been replaced.  
Drag the replacing key back to its original position, to restore the values. 

 
To copy a PC key to another PC key: 

PowerTerm enables you to copy the function of one PC key to another PC key. 
Hold the <Ctrl> key, in the Keyboard Mapping dialog box, while you drag the PC key 
whose function you want to copy to the required PC key. Both keys now have the same 
functionality. 

 
To restore the default keyboard mapping of all mapped keys: 

Click the Default button, in the Keyboard Mapping dialog box. 

Saving and Opening Keyboard Mapping Settings 

PowerTerm enables you to save keyboard-mapping settings in separate files and open them at a 
later date. 
 
To save keyboard mapping settings: 

Select File | Save Keyboard File. The Save Keyboard File dialog box appears. 
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Select the directory in which you want to save the file. 2 
3 
4 
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Enter a file name. The file extension .kbd is automatically added to the file name. 
Click Save. The keyboard-mapping file is saved. 

 
To open a predefined keyboard mapping settings: 

Select File | Open Keyboard File. The Open Keyboard File dialog box appears. 
Select the directory in which the keyboard file is saved. 
Select the required file from the files list and click Open. Parameters defined in the 
selected keyboard file are now applied to the current session. 

Programming the Power Pad 

The Power Pad is a floating keypad for which its buttons can be programmed to execute 
customized PSL scripts. The buttons are by default named F1, F2, F3, and so on, with a few 
default function names, such as Clear, Enter and Insert. The number of displayed buttons and 
their names can be changed. You send the programmed command to the host by clicking the 
desired Power Pad button. For more information on how to create scripts, see Chapter 4: 
“Scripts”. 
 
To program the Power Pad: 

Select Options | Show Power Pad. The Power Pad appears. 
Right-click the Power Pad button that you want to program. The Power Pad Button 
dialog box appears. 
Type the Button Description (that is, the name that will appear on the Power Pad 
button). 
Type the Script Commands to be run by this Power Pad button. For example, “send 
<f13>”. You can type several scripts separated by semicolons. 
Click OK. The Power Pad button is now displayed with its new name and will execute 
the defined script.  

 
To adjust the number of buttons in the Power Pad: 

You can display a maximum of 10 rows and 10 columns in the Power Pad, whereas the defaults 
are 9 rows and 4 columns. 

Select Options | Power Pad Setup. The Power Pad Setup dialog box appears. 
Select the number of rows and/or columns that you desire from the dropdown boxes. 
Click OK. The Power Pad opens with the number of rows and columns specified. 

Saving and Opening Power Pad Settings 

PowerTerm enables you to save your Power Pad settings in separate files and open them at a later 
date. 
 
To save your Power Pad settings: 

Select File | Save Power Pad File. The Save Power Pad File dialog box appears. 
Select the directory in which you want to save the file. 
Enter a file name. The file extension .pad is automatically added to the file name. 
Click Save. The settings are saved. 
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To open predefined Power Pad settings: 

Select File | Open Power Pad File. The Open Power Pad File dialog box appears. 
Select the directory in which the Power Pad file is saved. 
Select the required file from the files list and click Open. Parameters defined in the 
selected Power Pad file are now applied to the current session. 

Programming Soft Buttons 

Along the bottom of the PowerTerm window are twelve programmable Soft buttons by default 
named from F1 to F12. These can be renamed and programmed to execute customized scripts. 
You send the programmed command to the host by clicking the desired Soft button.  
 
The Soft button parameters are saved automatically in the terminal setup file. 
 
To program Soft buttons: 

Right-click the Soft button that you want to program. The Function Button dialog box 
appears. 
Type the Function Description (that is, the name that will appear on the button).  
Type the Script Commands to be run by this button. For example, “exec notepad”. You 
can type several scripts separated by semicolons. 
Click OK. The Soft button is now displayed with its new name and will execute the 
defined script.  

Selecting Fonts 

PowerTerm enables you to use standard system fonts or select special PowerTerm fonts to be 
displayed in the PowerTerm window. 
 

System fonts are standard general-purpose fonts, which different attributes can be set. 
PowerTerm fonts are scaleable fonts, automatically calculated according to the screen size 
of the host application and whether the Unscaled screen option is selected or not. 

 
To select PowerTerm fonts: 

Select Terminal | PowerTerm Fonts. The PowerTerm window will now display PowerTerm 
fonts. 

 
To select system fonts: 

Select Terminal | System Fonts. The Font dialog box appears. 
Select the font, style, and size, as you desire. 
Click OK. The PowerTerm window will now display the selected system font. 
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Step 3: Defining Settings for a 
Terminal Emulation (Terminal 
Settings) 

PowerTerm enables you to define the terminal settings for connecting to a host. Once you have 
defined terminal settings, you can save them as a setup file. This file can be activated at startup or 
opened manually during a PowerTerm session. 
 
Each setting option is displayed in the format of a property page in the Terminal Setup dialog 
box.  

N
 

OTE You first have to select an emulation type and then define the other 
settings.  

 
 

The terminal settings provided by PowerTerm are:  
 

Emulation, displays supported terminal emulations and enables you to select a terminal type. • 
• 
• 
• 
• 
• 
• 
• 

¾ 
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General, defines parameters for the terminal emulation type. 
Display, defines display settings for the PowerTerm window. 
Keyboard, defines keyboard setup parameters. 
Printer, defines printer parameters. 
Tabs, defines tab stops in the work area. 
Colors, defines color settings for the PowerTerm window. 
Preferences, defines parameters that determine PowerTerm behavior and automate 
processes. 

I
 

MPORTANT The parameters that you define will only remain active for the current 
session, unless you save them in a setup file. For more information, see Step 5: 
“Saving the Terminal Setup File”. 

Emulation Property Page 

The Emulation property page displays the emulation terminal types available with this version 
of PowerTerm. The emulation type that you select changes the tabs (property pages) displayed in 
the Terminal Setup dialog box. Some emulation types also change the look of the PowerTerm 
desktop. For example, for 3270 and 5250 terminal types the work area is black and the toolbar 
contains fewer buttons. 
 
To define settings for terminal emulation: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Emulation tab. The Emulation property page is displayed. 
Select the terminal type that you require from the list of supported emulations. 
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General Property Page 

The General property page enables you to define parameters for the selected emulation type. 
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To define emulation parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the General tab. The General property page is displayed. 
Select the parameters that you require.  

 

NOTE The selected host application will usually determine the default option. 
 
 

The parameters displayed in the General property page are: 
 
Terminal ID Determines the ID returned by the emulation program to the 

host. Verify that you select an ID that the host application 
recognizes. 
 

NRC Set Determines the communication and keyboard character set for 
7-bit date only. You can either select None or one of the 
languages available. 
 

UPS Set Determines the communication and keyboard character set for 
8-bit data only. Select one of the available character sets. 
 

8 bit Controls Enabled when UPS Set is specified as Code Page 437 and up. 
Disable determines if 0x80 to 0xAF are displayed 
characters. 
Enable determines if 0x80 to 0xAD are control characters. 
0x9B all characters are displayed characters except 0x9B, 
which is a control character. 

 
Online Equivalent to Terminal | On Line (Off Line). 

 
New Line Determines whether the <Enter> key generates only a carriage 

return or a carriage return/line feed combination. 
 

Use 8 Bit Data Characters Select this parameter if the communicated data is in 8-bit 
character format. 
Clear it for 7-bit characters. When cleared, the 8th bit is 
truncated.  
If you receive 7-bit data, you can convert it to 8-bit data for 
printing on the slave printer. 

 
User Defined Keys (UDK)  Locked Determines whether applications on the host 

system can override your user-defined keys when you have 
defined a function key that conflicts from being overridden. 
Unlocked allows them to be overridden.  
UDKs let you use a single key for multiple keystrokes. To 

   
 



 
  

41

program the 15 UDKs, 256 bytes are available. The key 
definitions are loaded sequentially (from F6 to F20), so that 
if you reach the 256-byte limit, more definitions cannot be 
loaded. 

 
Cursor Keys Determines whether the four arrow keys generate ANSI-

standard control sequences for moving the cursor, or generate 
customized application program functions.  
 

Keypad Determines the effects of the numeric keypad on your 
keyboard. 
• 

• 

• 
• 
• 

• 

• 

• 

• 

• 

Numeric Keypad keys insert numbers. For example, 
pressing <7> on the numeric keypad is the same as typing 
<7> on the keyboard.  
Application Keypad keys generate control sequences that 
can be used by some applications. 

 
Cursor coupling Select this parameter to cause the cursor to remain visible 

during page scrolling. 
 

Status Line None Displays an emulation screen without the status line.  
Indicator Displays the status line. 
Host Writeable Displays the status line sent by the host.  

 

Unique parameters for the 3270 and 5250 emulation types: 

General ID Determines the ID returned by the emulation program to 
the host. Make sure you select an ID that the host 
application recognizes.  
Unscaled Screen Select this parameter if you want to 
disable the scaleable feature for PowerTerm fonts.  
Show Response Time Select this parameter if you want to 
display the number of seconds that elapsed between the 
time data was sent to the host and the host response time. 

 
Cursor Ruler Displays full-screen, vertical or horizontal lines as a cursor 

ruler. 
 

Cursor Controls the cursor display.  
 

Appearance Power GUI Displays data in a window with 3D look and 
feel.  
Show Frame Places a frame around the text area of the 
emulation. 

 
HLLAPI Names Specify HLLAPI names here. 

 
Code Page Specifies the keyboard mode. This sends the correct keystrokes 

for a specific country or language’s keyboard layout to the host. 
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Alternate Size • 

• 

¾ 
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• 

• 

• 

Enable Select to override the terminal alternate size with a 
specific size. 
Rows/Columns Type the required number. 

 

Display Property Page 

The Display property page enables you to define parameters that determine the appearance 
(display) of the PowerTerm window. 
 

NOTE For non-IBM emulations only. 
 

 

To define display parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Display tab. The Display property page is displayed. 
Select the parameters that you require. 

  
The parameters displayed in the Display property page are: 
 
General Reverse Display Colors Reverses the text and background 

colors in the work area.  
Unscaled Screen Select this parameter if you want to 
disable the scaleable feature for PowerTerm fonts. 
Autowrap Characters Wraps words at the end of a line 
and the cursor moves to the next line. 
History Scroll Bar Displays the vertical history scroll bar 
along the right edge of the PowerTerm screen. This enables 
you to scroll through the data displayed previously on the 
screen. If the host transmits during scrolling, the display 
automatically scrolls back to its current position. Only with 
scaled screen. 

 
Cursor Ruler Displays full-screen, vertical or horizontal lines as a cursor 

ruler. 
 

Cursor Controls the cursor display. Experiment with each parameter to 
view the options available. 
 

Ctrl Characters Interpret Displays normal text as affected by control 
characters. 
Display Actually displays the control characters. 

  
Power GUI Displays data in a window with 3D look and feel. 

 
Show Frame Places a frame around the text area of the emulation. 
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Dimensions Determines the number of characters (columns) per displayed 
line, and the number of lines to be displayed in the work area. 
Characters are scaled according to the selected values. 
Type a different value in the Other box instead of choosing one 
of the standard options (80 and 132). 
 

Scrolling Determines the pace at which data is displayed in the work area 
as it arrives. If you select Jump, you should determine the 
Jump Scroll Speed that is measured in number of line units. 
The higher the value, the faster the scrolling. 
• 
• 
• 

¾ 

1 
2 
3 

• 

• 

Unlimited Displays data without delaying communication. 
Page Scrolls data by full screens. 
Smooth is equivalent to a Jump Scroll Speed of 1. 

 
Enable Soft Fonts Enables you to work with VT soft fonts. The fonts will be 

loaded from the host application. 
 

Keyboard Property Page 

The Keyboard property page enables you to define keyboard parameters for your PC. 
 
To define keyboard parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Keyboard tab. The Keyboard property page is displayed. 
Select the parameters that you require. 

 
The parameters displayed in the Keyboard property page are: 
 
Backspace Key Sends Determines whether the <Backspace> key sends Delete or an 

actual Backspace. 
 

Auto Repeat Repeatedly displays the character whose key is being 
continuously pressed down. 
 

Key Click Issues a click sound when you press a key on the keyboard. 
 

Local Echo Determines whether keyboard input is displayed (echoed) on 
your screen. 

Select to display the keyboard input even if the host system 
does not echo your input.  
Clear to send the keyboard input to the host system without 
being displayed on the screen (unless the host system 
echoes the characters). 

 
Use Emulator Alt Keys Select to make an <Alt> key perform the terminal operation 

even if Windows OS have an operation on the same key. 
 

Margin bell Determines whether the terminal sounds a bell tone when the 
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cursor reaches the right margin. 
 

Warning Bell Determines whether the terminal sounds a bell tone when 
receiving the “bell” (ASCII 7) character. For operating errors, 
mail messages etc. 
 

Use VT Keyboard Mode Transforms your keyboard to Digital VT keyboard mode. In 
this mode, the PC keyboard operates as close to a VT keyboard 
as possible, and takes full advantage of LK450 Digital 
keyboards. 
 

Use Shift Lock Select to simulate Shift Lock mode. For example, if you type 
“a”, the keyboard issues “A”. 
 

Answerback Message Specifies an answerback message and its display. 
• 
• 

Clear Deletes the message. 
Conceal Hides the message without being deleted. Click 
Clear to cancel the conceal command. 

 
Auto Answerback Determines whether the terminal automatically sends the 

message to the host system after you make the connection. This 
is useful if your answerback message is a command to the host 
system.  
 

Unique parameters for the 3270 and 5250 emulation types: 

Backspace Select to delete characters by pressing the Backspace key. 
 

Auto Repeat Repeatedly displays the character for which its key is being 
continuously pressed down. 
 

Key Click Issues a click sound when you press a key on the keyboard. 
 

Typeahead Types data ahead before the host responds. 
 

Use Emulator ALT Keys Select to make an <Alt> key perform the terminal operation 
even if Windows OS have an operation on the same key 
 

Use Shift Lock Select to simulate Shift Lock mode. For example, if you type 
“a”, the keyboard issues “A”. 
 

Numpad Decimal Sends 
Comma 

Determines whether the Numeric Pad sends a comma instead 
of a decimal. 
 

Lock Numeric Field Determines whether the keyboard is locked when you try to 
enter non-numeric data to numeric only fields. 
 

Non SNA System Wait Determines whether the System Wait in the IBM 3270 
emulation will act as a System Wait in a non-SNA terminal. 
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Printer Property Page 

The Printer property page enables you to define printer parameters for your PC. 
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• 

• 

• 

• 

• 
• 

• 
• 

• 
• 

To define printer parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Printer tab. The Printer property page appears. 
Select the parameters that you require.  

 
The parameters displayed in the Printer property page are: 
 
Print Device Allows you to select a printing output channel.  

None No destination was assigned. The Device File Name 
is disabled. Printer data is received by the terminal, but 
discarded (not printed). 
Print Manager Sends printing to the standard Windows 
Print Manager, in text mode. 
Device Sends printing to the device you designate in the 
Device Name text box. This can be a device such as PRN, 
lLPT1, COM1, etc. In the Device Name text box, you can 
also specify communication parameters. For example: 
COM 1:9600,8. 
File Sends printing to the file you type in the File Name 
text box. 

 
Device File Name File Creation Enables you to choose whether to add new 

data to an already existing file or to create a new one. 
Append Adds data to an existing file. 
Overwrite Creates a new file. 

 
Use Form Feed Adds a form feed (page eject) after each printing job, if you are 

printing to a file. 
 

Print Line Graphics As Text Converts line graphics to text. This speeds up printing on a 
slow dot-matrix printer. 
 

CR->CRLF Adds a line feed after each single carriage return (one that has 
no line feed following it) when in slave printing mode. 
 

Print Screen Data 
Conversion 

Converts data to IBM or Digital character sets. 
None Does not convert data. 
Graphics Prints in Graphics mode. Will always send a 
print screen via the Print Manager regardless of the print 
device. 

 
Slave Printer Data 
Conversion 

Converts data to IBM or Digital character sets for slave 
printing. 

None Does not convert data.  
Graphics Prints to a postscript printer. 
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Slave Printer Job Delimiter Specifies the job delimiter character that will divide the data 

into print jobs, thus disabling the escape sequences arriving 
from the host application. 
 

Delay for Print Closing 
(Seconds) 

The command to close the printer queue is delayed by the 
number of seconds that you determine. This command only 
takes effect if no open command is issued in the meantime. 
Important for printing to cut sheet printers (for example, 
inkjets/lasers) and network printers. 
 

Advanced Printing 

The Advanced Printer Setup dialog box enables you to define printer parameters. 

Non 5250 printing 

There are two different modes with different fields enabled: 
Text mode is designated in the Printer property page by setting the two data conversion 
combo boxes (Print Screen and Slave Printer) to None. 

• 

• 

¾ 
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Graphics mode is graphic printing. 
 
To set values for non-host print transform in non-graphic mode: 

Select the Printer property page. 
Click the Advanced Printing button. The Advanced Printer Setup dialog box appears. 
Select your printer model, or a compatible one, from the Printer/Type Model drop down 
list. 
Use the initial printer values that appear in the Font, CPI, LPI, Printer Columns and 
Printer Rows combo boxes or override them by clearing the Ignore check box and 
selecting the desired value from the adjacent combo box. 
Click OK. 

 
The parameters displayed in Text mode are: 
 
Printer Type/Model Specifies the destination printer. 

 
Ignore Disables the adjacent combo box. When selected, default values 

are applied. 
 

Font Printer default font and size will be applied to the output when 
Ignore is selected. Otherwise, User input will be applied. 
Select the desired font from the Font dropdown list. 
 

LPI Lines Per Inch 
 

CPI Characters Per Inch 
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Printer Columns Determines the number of printer columns in the output.  
Select Ignore to apply the number of columns on your 
emulation screen to the output. For graphic printing. 
 

Printer Rows Determines the number of printer rows in the output.  
Select Ignore to apply the default values of the specific 
emulation to the output. For graphic printing. 
 

Orientation For Non Graphic printing. 
Specifies the orientation of the printed output. The default 
depends on your printer’s settings. 
 

 
Graphics mode parameters: 
 

Printer Columns and Printer Rows are the only relevant fields. • 
• 
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Select the desired Orientation in the Print Setup dialog box. 

TN5250 Printing Session 

To set values for non-host print transform in non-graphic mode: 

Select the Printer property page. 
Click the Advance Printing button. The Advanced Printer Setup dialog box is 
displayed. 
Select your printer model, or a compatible one, from the Printer/Type Model drop down 
list.  
Use the host values for the Font, CPI, LPI, Printer Columns and Printer Rows or 
override them by clearing the Use Host Value check box and selecting the desired value 
from the adjacent combo box. 
Click OK. 

 
 
To enable host print transform: 

NOTE For IBM printer only. 

 

 
 

Select Enable Host Print Transform. 
Select the manufacturer printer type and model from the Printer Type/Model dropdown 
list. 
Select the paper size from the Drawer 1 dropdown list. 
Select the paper size from the Drawer 2 dropdown list. 
Select the paper size from the Envelope Hopper dropdown list. 
Specify whether the printer has Code Page 899 installed in the Supports ASCII Code-
Page 899 check box. 

 
Additional steps for Other Printers: 

Specify the Customizing Object. 
Specify the Customizing Object’s Library. 
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The parameters displayed are: 
 
Enable Host Printer 
Transform 

Enables the host to send the printer specific format commands 
to the emulation. When disabled, the host sends general format 
commands in which the emulation in turn, translates to printer 
specific commands.  
 

Printer Type/Model 
 

Specifies the destination printer. 
 

Drawer 1 Specifies the size for the paper in Paper Source 1. 
 

Drawer 2 Specifies the size for the paper in Paper Source 2. 
 

Envelope Hopper Specifies the size of the envelope. 
 

Supports ASCII Code-Page 
899 
 

Specifies whether the printer has Code Page 899 installed. 
 

Customizing Object Specifies the object name that you have previously defined on 
the AS/400. 
Enabled only for Other Printer model. 
 

Library Specifies the customizing object’s library on the AS/400. 
Enabled only for Other Printer model. 
 

Tabs Property Page 

NOTE For VT emulations only. 
 
 

 
The Tabs property page enables you to determine tabs in the work area. Tabbed data received 
from the host will be laid out in the work area according to ruler settings defined with this option. 
 

¾ 
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2 
3 

To define tab parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Tabs tab. The Tabs property page is displayed. 
Select the parameters that you require. 

 
The parameters displayed in the Tab property page are: 
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Tab Stops Click anywhere within the Tab Stops area to set tab stops 
manually. 
• 

• 

¾ 

1 
2 
3 

Set Every Sets a tab stop in increments of a number typed 
in the adjacent text field.  
Clear All Clears all tab stops. 

 

Colors Property Page 

The Colors property page enables you to define the color of data displayed in the work area.  
 
To define color parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Colors tab. The Colors property page is displayed. 
Select the parameters that you require. 

 
The parameters displayed in the Colors property page are: 
 
Preview Box Shows the result of your selections.  

 
Enable Underline Enables underlined characters.  

Clear to disable displaying data with the underline, for data 
transmitted from the host with the Underline attribute. 
 

Enable Blink Enables blinking. 
Clear to disable blinking data, for data transmitted from the host 
with the Blink attribute. 
 

Disable Host Colors Select to ignore specific color assignment by the host. Uses 
colors you select for the attributes only. 
 

Show BMP Specifies a Bitmap Screen as the background for the emulation 
window. The desired bitmap should be named pt_bg.bmp and 
should be copied to the PowerTerm folder. 
 

Select Attribute Select the attribute for which you want to define foreground 
and background colors. Attributes change according to the 
emulation type you selected in the Emulation property page. 
Generally, the attribute of the entire screen is Normal. The 
color for the Normal attribute determines the color of the entire 
work area. 
 

Text Select the color that will apply to the text (foreground) of the 
display. 
 

Background Select the color that will apply to the background of the text. 
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Preferences Property Page 

The Preferences property page enables you to determine PowerTerm behavior and automate 
processes. They remain active until you change them. For example, if you select to connect 
automatically at PowerTerm startup, you will always be connected when you open PowerTerm, 
until you change this setting in the Preferences property page. 
 

¾ 
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• 
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• 

• 

• 

To define PowerTerm preferences: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Preferences tab. The Preferences property page is displayed. 
Select the parameters that you require. 

 
The parameters displayed in the Preferences property page are: 
 
On Terminal Setup File 
Open 

Auto Connect Connection is established immediately with 
the parameters saved in the default setup file. 
Show Connect Dialog box Connection is not established 
immediately. The Connect dialog box opens, enabling you 
to select the connection parameters that you require. 
Do not Connect The PowerTerm window opens. You 
decide what to do. 

 
Window Title Enables you to give the currently active window a name of your 

choice. 
 

History Buffer Specifies the size of the buffer in which data is stored, by 
selecting an option from the dropdown list. 
 

On PowerTerm Exit Save Terminal Setup The new terminal parameters (if you 
changed them) are saved to the current terminal setup file. 
Confirm Save Terminal parameters are not saved 
automatically. PowerTerm displays a dialog box where you 
can decide whether or not to save.  
Save Window Size & Position Saves the size and position 
of the emulation window. Next time you open PowerTerm, 
the window appears with the same size and position as last 
time. 
Confirm Disconnect Session If you close PowerTerm 
during a session, you will be requested to confirm 
disconnect. 
Inactivity Timeout Specifies the time limit for keyboard 
inactivity, after which time PowerTerm shuts down. 

 
On Session Exit Auto Reconnect Re-establishes communication if the line 

was dropped. 
Auto Exit PowerTerm Closes PowerTerm altogether on 
disconnect. 
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Step 4: Defining Modem and 
Communication Settings 

Modem Settings 

Modem settings enable you to add customized modem definitions, edit initialization strings for 
existing modems as well as modify and delete modem definitions. 
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To define modem settings: 

Select Communication | Modem Setup. The Modem Setup dialog box appears. 
Select the required modem settings. 
Click OK. Your modem settings are defined. 

 
To add modem settings: 

Select Communication | Modem Setup. The Modem Setup dialog box appears. 
Type the modem name in the Modem Name field. 
Type the initialization string in the Init String field. 
Click Add. The new modem settings appear in the Modem List. 

 
To modify modem settings: 

Select Communication | Modem Setup. The Modem Setup dialog box appears. 
Select the modem you want to modify from the Modem List. The parameters of the 
selected modem appear in the Modem Information fields. 
Enter the new parameters in the Modem Name and Init String fields. 
Click Modify. The selected modem’s settings are updated. 

 
To delete modem settings: 

Select Communication | Modem Setup. The Modem Setup dialog box appears. 
Select the modem you want to delete from the Modem List. The parameters of the 
selected modem appear in the Modem Information fields. 
Click Delete. A confirmation message is displayed. 
Click OK to delete the selected modem. 

 
To clear Modem Information fields: 

Select Communication | Modem Setup. The Modem Setup dialog box appears. 
Select a modem from the Modem List. The parameters of the selected modem appear in 
the Modem Information fields. 
Click Clear. The Modem Information fields are cleared, and you can redefine the 
information. 

 
 
Modem Name Specifies the name of the modem. 

 
Init String Specifies the initialization string, which defines the way the 

   
 



 
  

52

modem communicates with another modem. 
 

Modem List List of available modems. 
 

Add Adds modem settings to the Modem List. 
  

Modify Updates data entered in the Modem Information fields for a 
selected modem. 
  

Delete Deletes selected modem settings. 
  

Clear Clears the Modem Information fields for the selected modem. 
  

Communication Settings 

Communication settings enable you to define the session type, session parameters and select the 
script file and setup file. Communication and terminal settings are both saved in a setup file. This 
file can be used on PowerTerm startup or opened during a PowerTerm session. For more 
information, see Step 1: “Starting PowerTerm” and Step 5: “Saving the Terminal Setup File”. All 
sessions in the Sessions List are saved in the ptcomm.ini file. 
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To define communication settings: 

Select Communication | Connect. The Connect dialog box appears.  
Select a Terminal Type from the dropdown list. 
Click a Session Type. Available types differ according to the selected Terminal type. For 
each Session type, PowerTerm displays a set of parameters.  
Enter required parameters or select a predefined Setup file. A predefined Script file can 
also be selected. 
Click Connect. Host connection is established. For more information, see Step 6: 
“Connecting to a Host”. 

 
Terminal Type Changes the current emulation. 

 
Terminal ID Changes the ID returned by the emulation program to the host.  

 
Device Name For 5250 Display.  

Each new session can automatically be given a new name, 
followed by the session number (when using multiple sessions). 
For example, if the device name is Test, then the first session 
would be Test 1, and the next Test 2, and so on. 
 

Dial Number For COM Session type. 
Specifies the number to be dialed by the modem before 
communication is established. 
 

Script File Specifies the name of a script to be run before communication 
is established. 
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Setup File Specifies the name of a setting to be opened before 
communication is established. 
 

Connect Connects to the host according to the displayed session 
parameters. 
 

Save As Saves the current session settings. 
 

Modify Updates a selected session setting, with the data entered in the 
upper section of the dialog box. 
 

Delete Deletes a session setting. 
 

Session Types 

TELNET Uses the Telnet protocol over TCP/IP for network 
communication. 
• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

You must specify the host computer name or the IP address 
in the Parameter’s Host Name field.  
You can also specify the Telnet Port Number (default is 
23).  
The winsock.dll file must be on the search path. 

 
COM Uses serial communication with the PC’s COM ports.  

You must specify the Baud Rate, Port Number, Parity, 
Stop Bits and Flow Control fields. 
Optionally, you can specify a Dial Number (telephone). 

 
BAPI For TCP/IP connections with parameters similar to those of 

TELNET. 
Verify that the BAPI support software is installed on your 
PC before you use this option. 

 
CTERM Uses the DIGITAL CTERM protocol for network 

communication with a remote or local VAX/Open VMS 
host via DIGITAL PATHWORKS 32. You must specify 
the host computer name in the parameter’s Node Name 
field. 

 
LAT Uses DIGITAL LAT protocol for network communication with 

a VAX/OpenVMS host via DIGITAL PATHWORKS 32.  
You must specify Service Name and a Password (if 
required). 

 
TN3270 TELNET for 3270.  

Select Use TN3270E Protocol if you want to work with 
TELNET SNA extensions.  
You can also specify the LU name of the host (LU name or 
LU pool). 
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MS SNA Server For connection via Microsoft SNA Server.  

• 

• 
• 

• 

• 

• 

• 

• 

• 
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Specify the LU Name (or LU pool). 
 

NWSAA (IPX) For connection via IPX to Novel Netware for SAA. The 
Service Name is the same as Novel’s Profile.  

You must select an LU Category.  
You can specify an asterisk, as the Server Name and 
PowerTerm will connect to the appropriate Netware for 
SAA server. 

 
NWSAA (TCP/IP) Same as previous for TCP/IP connection.  

You must specify the server’s IP address or host name in 
the Server Name field. 

 
TN5250 TELNET for 5250. 

 
APPC Specify the appropriate AS/400 names in Host Name and 

Device Name. 
Select Auto SignOn if you want to skip the sign on stage. 

 
RLOGIN Uses the RLOGIN protocol over TCP/IP for network 

communication.  
You must specify the host computer name or the IP address 
in the Host Name field.  
You can also specify the port number in the Host Name 
field. 

 
SUPERLAT This is a version of the LAT protocol for network 

communication with a VAX/OpenVMS host, which requires 
Meridian’s SUPERLAT.  

You must specify Service Name and Password (if 
required). 

 
 
To enter a Device Name: 

Type “<desired device name>+” in the Device Name field. 
 
To specify a Dial Number: 

Type the desired number in the text box. 
or, 

Click the browse button. The Quick Dial Setup dialog box appears with the modem list 
of available dial numbers. 
Select the desired name from the Dial List. 
Click OK. 

 
To add a Quick Dial Number: 

Type the Name you want to appear in the Dial List. 
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Enter the Dial Number. 2 
3 
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Click OK. 
 
To specify a Script file:  

Type the desired file name in the text box. 
or, 

Click the browse button. The Browse Login Script dialog box appears. 
Select a file and click Open. 

 
To specify a setup file:  

Type the desired file name in the text box. 
or, 

Click the browse button. The Browse Terminal Setup dialog box appears. 
Select a file and click Open. 

 
To select a predefined session: 

Select a session by clicking its name in the Sessions List. Its parameters appear in the dialog 
box. 

 
To save a session: 

Define session parameters. 
Click the Save As button. The Save Session dialog box appears. PowerTerm offers a 
default session name. You can overwrite this name and specify your own session name. 
Click OK. The session is displayed in the Sessions List.  

 
To modify a session: 

Select the session you want to modify from the Sessions List. 
Enter the new parameters in the upper section of the Connect dialog box. 
Click Modify. The new parameters are updated. 

 
To delete a session: 

Select the session to delete from the Sessions List. 
Click Delete. A confirmation message is displayed.  
Click OK to delete the session setting. 
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Step 5: Saving the Terminal Setup File 

Defined terminal and communication settings can be saved in a setup file. The default Terminal 
Setup file extension is .pts. This file can be used to start PowerTerm, to connect to a host using 
the predefined terminal and communication parameters, or opened manually during a PowerTerm 
session. Changes in settings can be saved to the currently loaded setup file, or under a different 
file name if you do not want to overwrite the parameters in the current setup file. Creating an icon 
for your current PowerTerm settings, which can be accessed from the Windows Start menu or by 
double-clicking on your desktop icon, is also possible as well as saving the settings when you exit 
PowerTerm. For more details about saving a setup file when exiting PowerTerm, see Step 9: 
“Exiting PowerTerm”. 
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To create a shortcut for session settings: 

Locate the PowerTerm shortcut (either on your desktop or in the Start Menu folder). 
Right-click Properties. The PowerTerm Properties dialog box appears. 
In the Target area, position your cursor after the quotation mark (“). 
Type a space and then the name of the required setup file. In the event that the setup file 
is in a directory other than that of PowerTerm, type the entire path of the setup file. 

N
 

OTE PowerTerm recognizes Windows file naming conventions, including 
spaces in a file name. If you have a setup file with a space in the 
name, for example Setup 1.pts, PowerTerm ignores the space and 

looks directly for the .pts extension. 
 

Click OK. Next time the PowerTerm window will be displayed using the parameters 
defined in the specified setup file. 

 
To save terminal settings to the current setup file: 

Select File | Save Terminal Setup. The current terminal settings are saved. 

N
 

OTE This option overwrites parameters previously defined in the setup file. 
 
 

To save a terminal setup file under a different name: 

Select File | Save Terminal Setup As. The Save File As dialog box appears. 
Select the directory in the Save in dropdown box in which you want to save the file.  
Type the desired file name in the File name text box. 
Click Save. The file is saved. 

 
To save PowerTerm settings as an icon: 

Select File | Save As Icon. The Save As Icon dialog box appears. 
Type the Icon Information that you want to use for your icon.  
Click OK. 
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NOTE The name of the setup file should be changed to avoid changing the 
default settings. 

 
 

To open a setup file: 

Select File | Open Terminal Setup. The Open File dialog box appears. 
Select the directory in the Look in dropdown list in which the setup file is located. 
Select the required setup file from the files list. 
Click Open. Parameters defined in the selected setup file are now available. 
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Step 6: Connecting to a Host 

Once you have defined terminal and communication parameters you can connect to a host. It is 
not relevant if you started PowerTerm automatically with a terminal setup file or with a script 
file. The communication mode appears beside the application name on the PowerTerm window 
title bar. When communication ends, the mode name disappears from view. 
 
PowerTerm enables you to connect to a host using a customized PSL script, when working with 
more than one host. You need to define a different script with the name of each host. This option 
provides you with a Windows shortcut to a host. For more details on how to start PowerTerm 
using a customized setup file, see Step 1: “Starting PowerTerm/Starting PowerTerm Using a 
Script”. 
 
PowerTerm also provides the option to modify connection parameters for COM type 
communications. This option is only available once you are connected to a host. 
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To establish a connection: 

Select Communication | Connect. The Connect dialog box appears. 
Click Connect. Connection with the host computer is established using the current 
communication (session) parameters.  

 
To modify a connection to a host: 

Select Communication | Modify Connection. The Modify Connection dialog box 
appears with its title bar indicating the session type. 
Change the session parameters (but not the Session Type), and the Script File as 
required. For more information, see Step 4: “Defining Modem and Communication 
settings”. 
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Step 7: Working with the Host 

Once you have connected to a host, PowerTerm enables you to perform the following functions: 
 

Transfer files to and from the host • 
• 
• 
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Print data from your host application 
Start a new PowerTerm session 

Transferring Files 

PowerTerm enables you to transfer files between the PC and the host. PowerTerm operates with 
both ASCII and non-ASCII files. Before transferring files, you need to define the PC and host 
data types. These are defined in the File Transfer Setup dialog box. 
 

NOTE File transfer for 5250 emulations is not supported. 
 
 

To define host and PC data types for file transfer: 

Select Communication | File Transfer Setup. The File Transfer Setup dialog box 
appears. 
Select Convert Data. 
Select data types for the host and PC data from each one’s respective dropdown list. 
Click OK. 

 
To receive a non-ASCII file from the host: 

Connect to a host. 
Type in the work area, the command that the host uses to send a file and press <Enter>. 
Select Communication | Receive File. The Receive File dialog box appears. 
Click any tab, except the ASCII tab. 
Click the browse button to specify a directory, if required.  
Type a file name in the File Name field.  
or, 
Leave “.” (or empty) if you want to receive the data into a file that carries the same name 
as the name used by the host. 
For Kermit functioning in Server mode, select the Use Get check box and specify both 
file names in the File Name and Host File Name text boxes. 
Click OK. The PC starts to receive the file, which will be saved on the PC disk under the 
specified name and directory. 

 
To receive an ASCII file from the host: 

Connect to a host.  
Type in the work area, the command that displays the file (for example: for UNIX, 
cat<filename>; for VAX, type<filename>). Do not press <Enter>. 
Select Communication | Receive File. The Receive File dialog box appears. 
Click the ASCII tab. 
Type in the File Name field, the PC file name that will store the received data. 
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Click OK. 6 
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Press Enter to activate the command. 
 

At the end of the capture process, select Communication | Stop Receiving ASCII File. 
 
To send a non-ASCII file from the PC to the host: 

Connect to a host.  
Type in the work area, the host’s file reception command and press <Enter>. 
Select Communication | Send File. The Send File dialog box appears. 
Click any tab, except the ASCII tab. 
Click the browse button to specify a directory, if required. 
Type a file name in the File Name field. 
Click OK. 

 
To send an ASCII file from the PC to the host: 

Activate the command that will accept the data on the host (for example: for UNIX, 
cat<filename> or enter an editor and move to the data entry state within the editor). 
Select Communication | Send File. The Send File dialog box appears. 
Click the ASCII tab. 
Type in the File Name field, the PC file name. 
Click OK. 

Transferring Files for 3270 Emulations 

PowerTerm provides IND$FILE transfer for 3270 emulation. 
 

NOTE All of the command’s parameters can also be modified in the ptdef.pts file 
under the [3270 IND$FILE] heading. 
 

To receive files from the host computer: 

Select Communication | Receive File. The IND$FILE: Receive File dialog box 
appears. 
Select the appropriate tab (CMS, TSO or CICS), which reflects your mainframe-
working environment. 
Specify the PC File Name and Host File Name. 
Modify the other parameters as required. 
Click OK. A File Transfer Status dialog box with file transfer details appears. 
 

To send files to the host computer: 

Select Communication | Send File. The IND$FILE: Send File dialog box appears. 
Select the appropriate tab (CMS, TSO or CICS), which reflects your mainframe working 
environment. 
Specify the PC File Name and Host File Name. 
Modify the other parameters as required. 
Click OK. A File Transfer Status dialog box with file transfer details appears. 
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The parameters displayed are: 
 
PC File Name The name of the file that resides on the PC. 

 
Host File Name The name of the file that resides on the mainframe. 

 
File Conversion • 

• 

• 

• 

• 

• 

• 

• 

• 

• 
• 
• 

• 
• 

ASCII Specifies converting the file to ASCII format. 
CR/LF Specifies deleting a carriage return and a linefeed 
character from the end of each line of the file you are 
sending, or adding them to the end of each line of the file 
you are receiving from the host. CR/LF processing is 
typically appropriate for ASCII files. 
Local Conversion Specifies converting the file according 
to the format specifications that appear in the above Host 
and PC fields. 

 
File Creation Append Specifies appending the transferred file onto an 

existing file with the same name. 
Overwrite Specifies that the transferred file overwrites an 
existing file with the same name. 

 
Record Format Default Specifies the default format for the file residing on 

the mainframe. 
Fixed Specifies the fixed format for the file residing on the 
mainframe. 
Variable Specifies the variable format for the file residing 
on the mainframe. 
Undefined Specifies an undefined format for the file 
residing on the mainframe. 

 
Allocation Units The unit in which to measure the primary and secondary Space 

allocation of disk space. 
Tracks Specifies Tracks as the allocation unit. 
Cylinders Specifies Cylinders as the allocation unit. 
AvBlocks Specifies the size (in blocks) for an average 
block. Relevant only where you are using blocks as your 
allocation unit. 

 
LRECL (Logical Record 
Length) 

Specifies the record size (in bytes) for the file being created on 
the host. For ASCII files, set this value to accommodate the 
longest line in your file.  

Range: 0 - 32768.  
Default: Lines of up to 80 characters. 

 
Block Size Specifies the block size (in bytes) for the file being created on 

the host. For files with fixed-length records, this value must be 
a multiple of the LRECL. 
 

Space Specifies the size (in allocation units) of the primary (left box) 
and secondary (right box) allocation for the host file being 
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created. In the event that the primary allocation is insufficient, 
then a secondary allocation is used. 
 

Additional Options Specifies any parameters specific to the IND$FILE program on 
your host system. The contents of this text box are attached to 
the end of the transfer command. 
 

Host program Specifies the name of the host program to be utilized by 
PowerTerm to initiate a file transfer.  
• 
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• 

• 

¾ 

• 
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• 
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Default (only valid option): IND$FILE 
 

Printing Data 

PowerTerm enables you to define print parameters and print the terminal screen or data 
transferred from the host application. 
 
To select a printer and set printing parameters: 

Select File | Print Setup. The Print Setup dialog box appears with a set of printing 
parameters. The displayed parameters change according to the printer you select. For details, 
consult your printer documentation. 
The Default printer parameter enables you to send the output to the default printer selected 
under Windows. 
The Specific printer parameter allows you to select one of the currently installed printers.  

 
To execute a form feed on the printer: 

Select File | Form Feed. 
 
To execute a line feed on the printer: 

Select File | Line Feed. 
 
To print accumulated data displayed in the work area: 

Select File | Start Auto Print. The Start Auto Print command starts accumulating 
incoming data while it is displayed on the screen, and the menu option changes to Stop 
Printing. 
Select File | Stop Printing. The Stop Printing command prints all the data accumulated 
in the printing buffer of the slave printer, or in the auto print buffer. If data was buffered 
with a printing request and communication failed before the data was sent to the slave 
printer, select this command to print the accumulated information. 

 
To print a session using device naming: 

Open a session. 
Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select 5250 Printer from the Emulation tab. 
Select the Printer tab and select File from the Print Device dropdown list. 
Type Lpt1 in the File Name field and click OK. 
Select Communication | Connect. The Connect dialog box appears. 
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Type the name of the AS/400 host in the Host Name field. 7 
8 
9 

10 

¾ 

1 
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• 
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• 

¾ 

• 

Type the name of the device for the printer session in the Device Name field. 
Click Connect. The Printer Session dialog box appears. Leave it open. The AS/400 
automatically creates a queue with the specified device name. 
Open another session, this one a 5250-display session, and send your print jobs to the 
queue created by the AS/400. 

 
To print the Terminal Screen: 

Mark desired text or the entire contents of the work area. 
Select File | Print Screen. 

Starting a New PowerTerm Session 

PowerTerm enables you to run two or more sessions concurrently by opening a new instance of 
the PowerTerm window. Each session is identified by a letter (starting at A), which appears in the 
session window title bar. A session is assigned the first available letter. For example, if A, B and 
D are opened, the next session opened is assigned C. 
 
To open a new instance of the PowerTerm window: 

Select File | New Terminal Window. A new instance of the PowerTerm window opens. 
 
To toggle between open sessions: 

Press <Ctrl>+<Spacebar>. 
 
To switch to a specific session: 

Press <Shift>+<Ctrl>+<X>, where X is the session letter. For example, if you want to work 
in session C, you would press <Shift>+<Ctrl>+<C>. 
or 
Click the desired session’s icon. 
or 
Select Sessions | desired session. 
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Step 8: Ending a PowerTerm Session 

You need to end the session(s) before exiting the PowerTerm application. PowerTerm provides 
four options to end a session: 
 

Automatic Closing PowerTerm enables you to close PowerTerm automatically when you 
close a session. If you have modified terminal parameters during a session, a message 
displays asking if you want to save the setup file before closing. 

• 

• 
• 
• 

¾ 

1 
2 
3 
4 

¾ 

1 
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¾ 

• 

¾ 

• 

Optional Closing. 
User-Initiated Closing Manually closing a session at any time. 
User-Initiated Fast Exit Sometimes you require a fast exit while communication is in 
progress. PowerTerm then reacts according to the parameters selected in the Preferences tab 
in the Terminal Setup dialog box. For more details on how to exit PowerTerm, see Step 9: 
“Exiting PowerTerm”. 

 
To define parameters for closing a PowerTerm session automatically: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Preferences tab. 
Select Auto Exit PowerTerm in On Session Exit. 
Click OK. 

 
To automatically reconnect a PowerTerm session after exiting the 
current session: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Preferences tab. 
Select Auto Reconnect in On Session Exit. 
Click OK. 

 
To manually close a session: 

Select Communication | Disconnect. 
 
To fast exit the current session: 

Press <Alt>+<F4>. 

Optional Closing 

NOTE For non-IBM emulations only.  
 
 

 
PowerTerm displays the following message at session termination when Auto Exit PowerTerm 
in the Terminal Setup dialog box is cleared: 

“Session closed (<exit code>). Hit Enter to restart session.” 
 
<exit code> may have one of the following values: 
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Zero (0) Communication ended successfully. • 
• 

¾ 

• 

Any number (other than 0) Communication aborted. The exit code points to the error that 
caused the problem. 

 
To re-establish communication: 

Press Enter to re-establish communication based on the current terminal and communication 
parameters. 
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Step 9: Exiting PowerTerm 

¾ 

1 

2 

To exit PowerTerm: 

Select File | Exit. If you have changed the terminal settings, PowerTerm displays a 
warning message asking if you want to update the terminal settings file. The message will 
point to the name of the setup file currently loaded.  
Click OK to update the file, or NO to cancel the latest changes and restore the default 
setup file. 
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Chapter 

 

Scripts 

The Power Script Language (PSL) is PowerTerm’s own programming language. It enables you 
to create scripts for automating tasks. PSL is intended for users with programming or scripting 
skills. 
 
For a full description of the different PSL commands, see the “PowerTerm Power Script 
Language, Programmer’s Reference”, available in pdf format. Each PSL command is also 
described in PowerTerm’s online help, which can be accessed by selecting Contents from the 
Help menu. 
 
This chapter describes the following topics: 
 

Script Overview • 
• Using PowerTerm Scripts 
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Script Overview 

PowerTerm enables you to use scripts to automate tasks. For example, you can create a script to 
login to PowerTerm, execute a file, display a message, etc. Scripts can be run upon startup or 
during a PowerTerm session. They can be written in any standard text editor, like Notepad and 
are saved with a .PSL extension. 

PSL Types 

The PSL commands can be grouped into different categories: 
 
Simulation transmission to 
host commands 
 

Enables you to communicate with the host. For examples, the 
<send> command sends data to the host. 

Standard programming 
commands 
 

Enables you to use standard programming commands. For 
example, the <exec> command opens a program. 

File handling commands Enables you to work with files. For example, the <read> 
command reads from a file. 
 

PowerTerm-specific 
commands 

Enables you to activate specific PowerTerm features. For 
example, the <map> command enables you to map a PC key to 
a host key. 
 

Desktop interface commands Enables you to manipulate components in the PowerTerm 
window. For example, the <menu hide> command hides the 
PowerTerm menu. 
 

DDE commands Enables you to use standard Microsoft Windows DDE 
mechanisms to communicate with other Windows applications. 
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Using PowerTerm Scripts 

PowerTerm provides you with the following script options: 
 

Create a Script creates a script to run upon startup or at any time during a PowerTerm 
session. 
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Edit a Script edits an existing script file. 
Record a Script creates a script by recording all the actions that you perform in the 
PowerTerm window. Actions can include selecting a menu option, typing an entry on the 
screen, making selections in a dialog box and so on. 
Run Scripts runs specific scripts or individual commands, upon startup or during a 
PowerTerm session, to automate specific tasks. You can only run saved scripts. 
Activate a recorded Script executes a non-saved script from the current memory. 
Save a recorded Script saves your scripts to be used at a later date. 

 
To create a script file: 

Select Script | Edit Script. The Edit Script dialog box appears. 
Specify the PowerTerm folder in the Look in field in which to store the new script. 
Type a name for the new script file in the File name field. You can type any name and 
extension that comply with DOS file-naming conventions. It is recommended that you 
use a .psl extension, because PowerTerm automatically recognizes it indicating a script 
file. 
Click Open. A message box displays, asking whether to create a new file. 
Click Yes. Notepad opens. 
Type the script command(s) that you require. 
Select File | Save. 
Exit from Notepad. 

 
To edit a script file: 

Select Script | Edit Script. The Edit Script dialog box appears. 
Double-click the required script file in the files list. Notepad opens and displays the 
selected script. 
Edit the script as required. 
Select File | Save. 
Exit from Notepad. 

 
To record a script: 

Select Script | Start Script Recording. The menu option changes to Stop Script 
Recording. 
Perform the manual operations that you want to record. For example, select a menu 
option, enter parameters in a dialog box, or type a password. 
Select Script | Pause Script Recording if you do not want to record certain operations. 
The script recording process pauses and the menu option changes to Continue Script 
Recording. 
Select Script | Continue Script Recording to resume script recording. 
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Select Script | Stop Script Recording when you have performed all the operations to be 
stored in the script. 

 
To run a script from startup by creating a Windows shortcut: 

This option creates a Windows shortcut to PowerTerm and a specific script file. It can be used to 
connect to different hosts using different scripts. 
 
The following procedure describes one way to create a shortcut. Consult your Windows 
documentation for a description of other available options. 
 

Locate the file ptw23.exe on your computer. 
Right-click and select Create Shortcut option. The Shortcut to ptw32.exe appears in 
the current folder. 
Right-click the created shortcut and select Properties option. The Shortcut to ptw32.exe 
Properties dialog box appears. 
In the Target field, position your cursor after the .exe file name. 
Add a space and then type the name of the required script file. 
You can also add parameters to the script file. These determine the communication 
parameters. For example, it can be the name of the host to which you want to connect, or 
the port number.  

Position your cursor after the PSL script name in the Target field 
Add a space and type the required parameters. Parameters should be separated by a 

space. 
Example: 
\PTW32\PTW32.EXE COMM.PSL 1 9600 xonxoff 
PowerTerm recognizes Windows file naming conventions, including spaces in a file 
name. If you have a setup file with a space in the name, PowerTerm ignores the space 
and looks directly for the .psl extension. 

Click OK. When you start PowerTerm, the script file is automatically executed and you 
are connected to the host that you specified in your setup file. 

 
To run a script file: 

Select Script | Run Script. The Run Script dialog box appears with a list of all the files 
in the PowerTerm directory that carry the .psl extension. 
Double-click the script file that you want to run. The selected script file is executed.  

 
To run a script file during a PowerTerm session using Soft buttons: 

Click the Soft button that has the desired script assigned. The script is sent to the host. For 
more information, see “Programming Soft Buttons”. 

 
To run a script file during a PowerTerm session using the Power Pad: 

Click the Power Pad button that has the desired script assigned. The script is sent to the host. 
For more information, see “Programming the Power Pad”. 

 
To run a script file upon connecting to a host: 

Select Communication | Connect. The Connect dialog box appears. 
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Type the desired script file in the Script File field or browse for it. For more information, 
see Step 6: “Connecting to a Host”. 
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To run individual script commands: 

Select Script | Script Command. The Script Command dialog box appears. 
Type the name of the script command you want to run. 
Click OK. The specified script command is executed. 

 
To activate a recorded script: 

Select Script | Activate Recorded Script. The script currently recorded in memory is 
activated. 

 
To save a recorded script: 

Select Script | Save Recorded Script. The Record Script dialog box appears. 
Select the directory in which you want to save the file. 
Enter a file name. The .psl file extension is automatically added. 
Click Save. The file is saved with the specific file name. 
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Menu Reference 

Chapter 

 

This chapter describes each of the PowerTerm Menu bar options. Use it for reference only. For a 
detailed explanation of each step involved, see Chapter 3: “Using PowerTerm” and Chapter 4: 
“Scripts”. 
 
The PowerTerm Menus are: 
 

File Menu • 
• 
• 
• 
• 
• 
• 
• 

Edit Menu 
Terminal Menu 
Communication Menu 
Sessions Menu 
Options Menu 
Script Menu 
Help Menu 
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File Menu 

The File menu provides options to create, save and restore a terminal setup file as well as create 
an icon for your current PowerTerm settings, open keyboard and Power Pad settings, and save 
them. You can also use this menu to set printing parameters, print and to open a new instance of 
the PowerTerm window. 

New Terminal Setup 

Restores the default parameters including the terminal display colors. If you have changed 
terminal parameters since the last save, PowerTerm displays a warning message asking whether 
or not to save the latest changes. The message points to the terminal settings file currently loaded. 

Open Terminal Setup 

Opens the Open File dialog box, which enables you to select and open an existing setup file. 

Save Terminal Setup 

Saves both terminal setup and communication parameters to the current setup file. 

Save Terminal Setup As 

Opens the Save File As dialog box which enables you to save the current setup file under a 
different name. 

Save as Icon 

Opens the Save As Icon dialog box to create an icon for the current PowerTerm settings file. This 
enables you to start a session automatically with the desired parameters either by accessing the 
icon from the Windows Start menu, or by double-clicking it on your desktop. 

Open Keyboard File 

Opens the Open Keyboard File dialog box, which enables you to open keyboard-mapping 
settings that have previously been saved. 

Save Keyboard File 

Opens the Save Keyboard File dialog box, which enables you to save keyboard-mapping settings 
in a separate file and open them at a later date. 
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Open Power Pad File 

Opens the Open Power Pad File dialog box, which enables you to open Power Pad settings that 
have previously been saved. 

Save Power Pad File 

Opens the Save Power Pad File dialog box, which enables you to save Power Pad settings in a 
separate file and open them at a later date. 

Print Screen 

Prints the contents of the work area, or the selected text. 

Print Setup 

Opens the Print Setup dialog box, which contains printing parameters. Displayed parameters 
change according to the printer you selected. 
 

The Default Printer parameter enables you to send the output to the default printer selected. • 
• The Specific Printer parameter allows you to select one of the currently installed printers. 
 
For more details about installing a new printer, consult your operating system documentation. 

Start/Stop Auto Print 

Prints all the data displayed in the work area. This option changes to Stop Printing once the 
Start Auto Print function is activated.  

Close Print Queue 

Closes the Windows print queue manually. 

Form Feed 

Executes a form feed on the printer. 

Line Feed 

Executes a line feed on the printer. 

New Terminal Window 

Opens a new instance of the PowerTerm window. This enables you to run several sessions 
concurrently and simulate more than one terminal type. You can access a session by switching 
windows. After opening a new terminal window, you should define terminal and communication 
parameters before connecting to a host. 
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Exit All Sessions 

Exits all sessions at once. 

Exit 

Enables you to exit PowerTerm. If you have changed the terminal settings, PowerTerm displays a 
warning message asking you if you want to update the terminal settings file.  
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Edit Menu 

The Edit menu provides options to select, clear, and reverse text in the PowerTerm window and 
delete the contents of the history buffer. The Edit menu also provides standard windowing 
editing commands (copy and paste), in addition to commands that enable you to copy data to a 
file and copy data automatically to the Clipboard. 

Select Screen 

Selects the contents of the entire work area. 

Clear Screen 

Captures the entire PowerTerm screen and passes the data to the history buffer. An example of an 
application that issues clear screen commands is VMS Mail. 

Reverse Screen 

Changes the paragraph alignment. You can type from left to right or right to left, depending on 
the language you are using. 

Clear History 

Deletes the entire contents of the history or scroll back buffer. This command is only available 
when the history buffer is in use. 

Copy 

Copies marked text to the Clipboard when the Automatic Copy option in the Edit menu is not 
active. 

Paste 

Pastes the clipboard into the work area. Right-click sends data stored on the Clipboard, to the 
host. This operation is equivalent to actually typing the contents of the Clipboard on the host 
screen. 

Copy to File 

Copies selected information to a file. If no text is selected, the entire screen is written to the file. 
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Automatic Copy 

Automatically copies selected information to the Clipboard with no need to select the Copy 
option. 
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Terminal Menu 

The Terminal menu provides options to define and reset connection parameters, set the system to 
be online or offline, and freeze or unfreeze the screen. The Terminal menu also enables you to 
select the system fonts you want to be displayed in the PowerTerm window, or use the default 
PowerTerm fonts. 

Setup 

Opens the Terminal Setup dialog box in which you can define settings for terminal emulations. 
This dialog box contains different property pages that enable you to define all aspects of your 
terminal setup. For more information, see Chapter 3, Step 3: “Defining Settings for a Terminal 
Emulation (Terminal Settings)”. 

PowerTerm Fonts 

Displays the default fonts defined in the PowerTerm window. The default PowerTerm fonts are 
scaleable so that if the window shrinks, the fonts will shrink in relation to the size of the window. 

System Fonts 

Displays the system fonts you want to be displayed in the PowerTerm window. System fonts 
remain the same size, no matter what the size of the window. When you select your own system 
fonts, you can only select fixed size fonts. System fonts enable you to select a different language. 

Reset 

Resets the VT terminal defaults. This command does not apply to PowerTerm’s exclusive 
terminal parameters (such as color). 

Online 

Sets the system to be online or offline. 

Hold Screen 

Stops communication and freezes the screen. To unfreeze the screen, reselect the command. 

English/ German/ French/ Italian/ Spanish/ 
Greek 

Selects each language for the desired PowerTerm interface. 

   
 



 
  

79

Communication Menu 

The Communication menu provides options to define and modify the communication (session) 
parameters, and to connect/disconnect a communication session. The Communication menu also 
provides file transfer options. It enables you to set and clear Data Terminal Ready (DTR) and 
Ready to Send (RTS) signals as well as select a modem from a list of existing modems. 

Connect 

Displays the Connect dialog box, which enables you to define session parameters and connect to 
a host.  

Modify Connection 

Displays the Connect dialog box, which enables you to modify connection parameters for COM 
type communication.  

Disconnect 

Disconnects the communication session. 

Modem Setup 

Opens the Modem Setup dialog box, which enables you to select a modem from a list of existing 
modems and initialization strings. It also enables you to add customized modem definitions and 
edit the initialization string provided. 

Reset Communication 

Resets the communication port for COM type communication. 

File Transfer Setup 

Displays the File Transfer Setup dialog box, which enables you to define host and PC data types 
for file transfer. 

Receive File 

Receives a file from the host via Kermit, Zmodem, Ymodem, Xmodem, Ascii or Binary. 

Send File 

Sends a file to the host via Kermit, Zmodem, Ymodem, Xmodem, Ascii or Binary. 
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Run FTP 

Launches the PowerTerm FTP Client capable of transferring files from one computer to 
another. 

Utilities 

Displays signal options. 

Dial 

Enables you to dial a specific phone number for COM type communication. 

Break 

Sends a break for COM type communication. Equivalent to <Ctrl>+<Break>. 

Set DTR 

Sets DTR (Data Terminal Ready) signals. 

Clear DTR 

Clears DTR (Data Terminal Ready) signals. 

Set RTS 

Sets RTS (Ready To Send) signals. 

Clear RTS 

Clears RTS (Ready To Send) signals. 

AUX: Modify connection 

Two-ways slave printing to a serial printer. 
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Session Menu 

A list of current PowerTerm sessions. You can toggle between the sessions by clicking the one 
you desire. 
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Options Menu 

The Options menu enables you to display and edit the keyboard mapping and define the Power 
Pad display. The Options menu also enables you to store a session in a log file and provides 
options to show or hide PowerTerm window components. 

Keyboard Map 

Displays the Keyboard Mapping dialog box, which enables you to map your PC keys to host 
keys on the terminal keyboard.  

Power Pad Setup 

Displays the Power Pad Setup dialog box, which enables you to adjust the number of buttons in 
the Power Pad. For more information, see Chapter 3: “Using PowerTerm/Programming the Power 
Pad”. 

Start/Stop Trace 

Stores the session in a log file. Raw data is stored in the Capture.log file, while formatted data 
with readable escape sequences is stored in the Trace.log file. This menu option changes to Stop 
Trace once the Start Trace option has been activated. 

Input Trace 

Enables you to view the contents of the Capture.log file on the PowerTerm desktop work area. 

Hide Menu 

Hides the Menu bar. To restore it, select Restore Menu from the Control Menu box. 

Hide Buttons 

Hides the Soft buttons. This option changes to Show Buttons when the Soft buttons are hidden. 

Hide Status bar 

Hides the Status bar. This option changes to Show Status Bar when the Status bar is hidden. 

Hide Tool Bar 

Hides the Toolbar. This option changes to Show Tool Bar when the Toolbar is hidden. 
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Show Power Pad 

Displays the floating Power Pad. This option changes to Hide Power Pad when the Power Pad 
is floating. 
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Script Menu 

The Script menu provides options to record, edit, and run a script.  

Run Script 

Displays the Run Script dialog box, which enables you to select and run a script. 

Edit Script 

Displays the Edit Scrip dialog box, which enables you to create a new script or edit an existing 
one. 

Script Command 

Displays the Script Command dialog box, which enables you to run individual script commands. 

Start/Stop Script Recording 

Writes a script automatically. After requesting Start Script Recording, the manual operations 
you perform in the emulation screen are recorded to a script file, until you choose the Stop Script 
Recording option. 

Pause Script Recording 

Pauses script recording. This enables you to exclude certain operations from recording. 

Activate Recorded Script 

Activates the script currently recorded in memory. The script is saved in memory while 
PowerTerm is active. 

Save Recorded Script 

Enables you to save a script from memory to a specific file to be used at a later date. 
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Help Menu 

The Help menu provides options for accessing the PowerTerm online help, Getting Started online 
help and product information. 

Contents 

Accesses the table of contents for the PowerTerm online help. 

Getting Started 

Accesses the table of contents for the PowerTerm online help. 

About PowerTerm 

Displays product and contact information. 

   
 



 
  

86

 

 
Chapter 

 

Introduction to the PowerTerm FTP 
Client 

This chapter presents PowerTerm FTP Client and its main features. A quick guide to the 
PowerTerm FTP Client is also provided. It describes the basic steps for users who are familiar 
with accessing remote terminals. 
 
This chapter includes the following topics: 
 

What is PowerTerm FTP Client? • 
• 
• 
• 
• 

Features and Benefits 
PowerTerm FTP Client Concepts 
The PowerTerm FTP Client Window 
A Quick Guide through PowerTerm FTP Client 
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What is the PowerTerm FTP Client? 

The PowerTerm FTP Client is a client-server application, which uses the File Transfer Protocol 
(FTP). It provides an easy to use graphic user interface to define how to transfer files between 
your computer (client) and remote computers (servers), across a wide variety of platforms like 
Unix, Windows, and more. It does not matter where the two computers are located, how they are 
connected, or whether they use the same operating system. 
 
PowerTerm FTP Client provides direct access to any FTP server site. The server side only 
requires a login identity and password before it responds to requests.  
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Features and Benefits 

Provides access to a wide variety of operating systems, including UNIX, Windows 
95/98/ME/2000/NT/XP, VAX/VMS, IBM AS400, IBM Mainframe operating systems (such 
as MVS, VSE, etc.) and more. 

• 

• 
• 
• 
• 
• 
• 
• 
• 
• 
• 

Saves connection parameters in a configuration file. 
Uses prompt messages to confirm actions.  
Provides detailed on-screen connection information. 
Provides a choice of Binary or ASCII data transfer modes. 
Provides a variety of data conversion options. 
Creates, removes and changes directories, as well as deletes and renames files. 
Views files in the format that they were created. 
Automates connection and transfer operations. 
Provides support for a variety of firewall options. 
Secures the connection for the file transfer using the SSH2 protocol. 
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PowerTerm FTP Client Concepts 

The following describes some important concepts, which are used in this guide: 
 
FTP Site The remote site to which you are connecting. In this guide this 

term is also known as a host or remote computer. 
 

Configuration Settings Configuration settings contain your PowerTerm FTP Client 
preferences and selected data transfer mode. These parameters 
only remain active for a current transfer session, unless they are 
saved in a configuration file. 
 

Connection Profile PowerTerm FTP Client enables you to create a connection 
profile for an FTP site with which you frequently establish 
communication. This profile contains login, system, directory 
and firewall information. The connections profile, along with 
configuration information, is saved in a configuration file. 
 

Connection List Connection profiles are displayed in a Connection List at the 
bottom of the Connect dialog box. You can select a profile 
from the list to connect directly to an FTP site. 
 

Configuration File The configuration file contains your connection profiles and 
configuration settings. Configuration files are saved with a .cfg 
extension. Default configuration file is ftp.cfg, which is loaded 
at startup. 
 

Current Session The current session refers to the current connection between 
your PC and remote computer. 
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The PowerTerm FTP Client Window 

 
 
The PowerTerm FTP Client Window consists of the following components: 
 
Control Menu Box Provides standard Windows commands. 

 
Title Bar Displays the application name (PowerTerm FTP Client) and the 

Configuration File currently in use. 
 

Menu Bar Contains drop-down menus, which enables you to access 
PowerTerm FTP Client functions. 
 

Toolbar Contains tools, which can be used as shortcuts to access 
frequently used menu commands. 
 

Display Area Displays information about a selected file, like file size, date 
and time for compilation etc. When you select more than one 
file, the combined size of files is shown. The Display Area also 
shows the current button, menu or toolbar option selected. 
When you connect to a remote PC, a message is displayed with 
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the name of the host to which you are connecting. 
 

Application Status Icon Displays the activity status of the PowerTerm FTP Client 
application. The icon is active while PowerTerm FTP Client is 
running. 
 

Menu Bar 

File Menu Provides options to create, open, and save a configuration file. 
You can also use this menu to exit the PowerTerm FTP Client 
application. 
 

Settings Menu Provides options to select preferences for file transfer and 
define the data translation mode. 
 

Services Menu Provides options to connect and display connection information 
in a log window. The Services Menu also enables you to 
refresh the file list in both the local and remote directory. 
 

Help Menu Provides product information. 
 

Toolbar 

New  

 
 

Creates a new configuration file. Equivalent to File | New. 
 

Open  

 
 

Opens an existing configuration file. Equivalent to File | Open. 
 

Save  

 
 

Saves a configuration file. Equivalent to File | Save. 
 

Options  

 
 

Enables you to select preferences for file transfer. Equivalent to 
Settings | Options. 
 

File Transfer Setup  

 
 

Enables you to select options for data conversion. Equivalent to 
Settings | File Transfer Setup. 
 

Connect  

 
 

Enables you to enter connection parameters for file transfer. 
Equivalent to Services | Connect. 
 

Log Window  

 

Displays connection details. Equivalent to Services | Log. 
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Refresh  

 
 

Refreshes the display of directories and file names shown in the 
PowerTerm FTP Client window. Equivalent to Services | 
Refresh. 
 

Exit  

 
 

Exits the PowerTerm FTP Client application. Equivalent to File 
| Exit. 
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A quick Guide through PowerTerm 
FTP Client 

The following workflow is a quick guide for using PowerTerm FTP Client. This quick guide is 
intended for users who are familiar with FTP applications. For a more detailed description on 
how to work with PowerTerm FTP Client, see Chapter 7: “Working with the PowerTerm FTP 
Client”. 
 

 

Step 1: Start PowerTerm FTP Client 

Select Communication | Run FTP. The PowerTerm FTP Client window opens. 1 
2 

• 

• 

Click Connect. The Connect dialog box appears. 

Step 2: Connect to an FTP Site 

The Connect dialog box enables you to define connection parameters and connect to an FTP site. 
PowerTerm FTP Client provides options to define connection parameters for a current session as 
well as to select a previously defined connection profile from the Connection List. 

To define connection parameters for the current session, enter the required parameters in the 
Connect dialog box. 
To save your connection profile for future sessions, type a profile name in the Description 
field and click Add. The connection profile is displayed in the Connection List. 
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• 
• 

• 

1. 
2. 

1. 
2. 

1 

2 
3 

To select a connection profile, click on a profile in the Connection List. 
To connect to the specified FTP site, click Connect. 

Step 3: Transfer Files 

Select Copy or Append in the lower part of the PowerTerm FTP Client window. 
 
Downloading files: 

Select the files to transfer in the Remote/Files field. 
Click the left arrow button. 

 
Uploading files: 

Select the files to transfer in the Local/Files field. 
Click the right arrow button. 

Step 4: Exit PowerTerm FTP Client 

Click Disconnect in the PowerTerm FTP Client window. A confirmation message is 
displayed. 
Click OK. 
Select File | Exit or use standard windowing procedures to close the PowerTerm FTP 
Client. 
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• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 

 
 
 
 
 

Chapter  
 
 
 
 

Working with the PowerTerm FTP Client 

This chapter describes how to define connection parameters for a current session. These 
parameters can be saved in a Connection Profile for future use. The Connection List displays the 
different profiles that you have created. This chapter also describes the procedure for connecting 
to an FTP site and how to display on-screen connection information. 
 
This chapter includes the following topics: 
 

Starting PowerTerm FTP Client 
Defining Configuration Settings 
Working with Configuration Files 
Defining Connection Parameters 
Working with Connection Profiles 
Connecting to an FTP Site 
Using the FTP-Log Window 
Working with Local and Remote Directories and Files 
Transferring Files 
Automatic File Transfer 
Disconnecting and Exiting PowerTerm FTP Client 
Troubleshooting 
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Starting PowerTerm FTP Client 

The PowerTerm FTP Client is opened using either the default (ftp.cfg) or a customized 
configuration file. You can also create a shortcut that at startup accesses the PowerTerm FTP 
Client with a specified configuration file. 

N
 

OTE Before you create a shortcut to a configuration file, you need to first 
create and save it in PowerTerm FTP Client, as described in “Working with 
Configuration Files/Creating a New Configuration File”. 

 
¾ 

• 

To start PowerTerm FTP Client: 

Select Communication | Run FTP in the PowerTerm window. The PowerTerm FTP Client 
window opens with the predefined configuration settings. 
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Defining Configuration Settings 

To set up your PowerTerm FTP Client working environment, you need to define PowerTerm FTP 
Client preferences and select the required file transfer mode. PowerTerm FTP Client also 
provides an option to select the data transfer conversion. 
You can save your own settings to a configuration file so that they can be used in later 
PowerTerm FTP Client sessions. For more information, see “Working with Configuration Files”.  

N
 

OTE The parameters that you define will only remain active for the current 
session, unless you save them. 
 

Defining PowerTerm FTP Client Preferences 

PowerTerm FTP Client provides various options to customize your working environment. You 
can specify which actions will prompt you with a confirm message (for example, removing a 
directory), and specify the information displayed when you connect to an FTP site. 
 

¾ 

1 
2 
3 

• 

• 

• 

• 

• 

• 

• 

To define PowerTerm FTP Client preferences: 

Select Settings | Options. The FTP-Preferences dialog box appears. 
Select the options that you require. 
Click OK. 

 
The parameters displayed are: 
 
Confirm Before Determines the actions which display a confirm message. 

Remove Directory Prompts you for confirmation before 
deleting directories from your computer or the remote FTP 
site. 
Append to File Prompts you for confirmation before 
appending (adding) a file to an existing file in your 
computer or the remote FTP site. 
Delete File Prompts you for confirmation before deleting a 
file from your computer or the remote FTP site. 
Replace File Prompts you for confirmation before 
overwriting a file in your computer or the remote FTP site. 

 
On Connection Determines the connection information displayed when you 

connect to an FTP site. 
Open Log Window Opens a temporary Log-FTP window, 
which displays the messages exchanged by your computer 
and the FTP site while connecting. This window enables 
you to monitor the status of the current FTP connection. 
Open Log File Saves connection details to a file, which 
you can then open and view at a later date.  
Clear Log File on Connect Clears the log file every time 
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you connect to an FTP site. Only the current connection 
information is saved in the log file. 

• 

• 

• 

• 

• 

• 

• 

Include Files List in Log Displays a list of the remote files 
in the Log-FTP window. To access this option select Open 
Log Window. If you want to save this list to the log file, 
select Open Log File. 

 
General Determines general information displayed when you use the 

PowerTerm FTP Client.  
Keep Version No. of VMS File Names Retains the version 
number of the VMS file names.  
Show File Size Displays the size of files in the lower part 
of the PowerTerm FTP Client dialog box. To view the size 
of files, you may need to enlarge your PowerTerm FTP 
Client window. You can use standard windowing Shift and 
Ctrl keys to select multiple files. The combined size of 
selected files is displayed in the PowerTerm FTP Client 
window area. 
Save Settings on Exit Automatically saves the current 
configuration settings when you exit PowerTerm FTP 
Client, without prompting you to save these settings. If you 
do not select this option, PowerTerm FTP Client will 
always prompt you to save the current configuration file 
when you exit the application. 
Password for Anonymous Login Provides PowerTerm 
FTP Client with a specified password for anonymous login. 
Type in your e-mail address in the Password field. 

 

Selecting a file Transfer Mode 

PowerTerm FTP Client distinguishes between transferring Binary data and transferring a text 
(Ascii) file. It is important to select the right transfer mode to obtain the correct information, 
when accessing files on host computers. By default, PowerTerm FTP Client transfers files in 
Binary mode. 
 

In Binary mode, data is copied bit by bit so that the original and the copy are identical. This 
mode is usually appropriate when transferring files between computers of the same type. 
Programs are usually transferred in Binary mode. For example .doc, .bat, .exe, and .dll files. 
In Ascii mode, data is treated as a set of characters (seven bit plus one bit for parity 
checking). The characters transferred have the same meaning on the target computer as they 
have on the source computer. This mode is appropriate for transferring textual data between 
two different systems, for example UNIX and Windows. Text files are usually transferred in 
Ascii mode. For example, files with the .txt extension. 

 
The following is a list of common file types and their recommended mode of transfer: 
 
Type of File Mode 

 
Text (.txt) file Ascii 

   
 



 
  

99

 
Spreadsheet file 
 

Usually Binary 

Database file 
 

Usually Binary 

Word Processor file 
 

Usually Binary 

Program source code 
 

Ascii 

Electronic mail message 
 

Ascii 

UNIX shell archives (shar) 
 

Ascii 

Compressed files (zip, tar, lzh, 
arc, Binary arj) 
 

Binary 

Unencoded files 
 

Ascii 

Executable files 
 

Binary 

Executable script files (bat, 
etc.) 
 

Ascii 

PostScript files 
 

Usually Ascii 

Hypertext (html)  
Documents 
 

Ascii 

Picture files (tiff, jpeg, mpeg) 
 

Binary 

Rich Text Format files (rtf) 
 

Ascii 

N
 

OTE When transferring files between UNIX FTP servers and Windows 
computers, select Binary mode if you are not sure about the kind of file you 
are transferring. 

 
¾ 

• 

¾ 

1 
2 

To select the data transfer mode: 

Click the Binary/Ascii button in the PowerTerm FTP Client window. The required mode is 
selected. 

File Transfer Setup Option 

PowerTerm FTP Client enables you to setup the Data Conversion mode and Data Type for both 
your computer and the remote computer (host). 
 
To select file transfer options: 

Select Settings | File Transfer Setup. The Data Conversion dialog box appears. 
Select the required file transfer setup parameters. 

   
 



 
  

100

Click OK. 3 
 
The parameters are: 
 
Data Translation Defines the mode of transferring files: no translation, Ascii 

Mode Translation, and Ascii and Binary Translation. 
 

Host Data Type Defines the data type for the FTP site: 7-Bit, 8-Bit (DOS-
Ascii), and 8-Bit (Windows-Ansi). 
 

PC Data Type Defines the data type for your PC: DOS-Ascii and Windows-
Ansi. 
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Working with Configuration Files 

A Configuration File consists of the configuration settings you have defined and your connection 
profiles. You can save configuration settings to the default ftp.cfg configuration file, create a new 
configuration file, or save the configuration file under a different name. All configuration files are 
saved with a .cfg extension. You can use previously defined configuration settings by opening an 
existing configuration file in PowerTerm FTP Client, or by starting PowerTerm FTP Client with a 
customized configuration file. To do this, you should add the name of the configuration file to the 
PowerTerm FTP Client shortcut. For more information see Chapter 7, “Setting up PowerTerm 
FTP Client/Starting PowerTerm FTP Client”. 
 

¾ 

• 

¾ 

1 
2 
3 

¾ 

1 
2 

• 

• 

¾ 

1 
2 
3 

To create a new configuration file: 

Select File | New. A new configuration file called noname.cfg is created in which you can 
specify the parameters that you require. 

 
To open an existing configuration file: 

Select File | Open. The Open Configuration File dialog box appears. 
Select the configuration file that you require. 
Click Open. The configuration file opens with the settings that you previously defined. 

 
To save a configuration file: 

Define configuration settings and connection profiles as required. 
Select File | Save. 

The file is saved without any confirmation prompt, if you have already saved the 
current configuration in a .cfg file. 
The Save File As dialog box appears if the current configuration file is noname.cfg. 

 
To save a file under a different name: 

Select File | Save As. The Save File As dialog box appears. 
Specify a name in the File Name field. 
Click Save. The file is saved with a .cfg extension. 
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Defining Connection Parameters 

PowerTerm FTP Client enables you to set parameters for connecting to an FTP site. These 
parameters include login, system and directory information. The last parameters that you 
specified in the Connect dialog box are kept and displayed when you re-open it (except the 
password).  

N
 

OTE The parameters that you define will only remain active for the current 
session, unless you save them. 

 
 

¾ 

1 
2 

• 

• 

• 

• 

• 

• 

• 

• 

To define connection parameters: 

Select Services | Connect or click the connect button. The Connect dialog box appears. 
Specify connection parameters. 

 
The following parameters are displayed: 
 
Login Host Name The remote computer that you want to access. 

Type the host computer’s domain name or its IP address.  
User Name The account that you want to use to access the 
remote computer. Select anonymous if you do not have an 
account on the FTP server. Enter your user name if you 
have a personal account on the remote computer.  
Password Enter your complete e-mail address for 
anonymous ftp. Enter the password that you have been 
assigned for personal ftp. PowerTerm FTP Client displays 
the characters that you type as asterisks.  
Account This parameter may be required for personal ftp, 
in addition to your user name and password. 

 
System Port A number that identifies an Internet application. 

Default port is 21. 
Type The operating system used by the remote computer. 
Default type is Auto. 

 
Directory Optional parameters.  

Local The local directory to or from which you want to 
transfer files. 
Remote The remote directory to or from which you want to 
transfer files. 

 
Description A name for the connection profile. 

 
Connection List Displays a list of the existing connection profiles. 

 
SSH-2 SFTP Specifies implementing the SSH2 security protocol during the 

file transfer. 
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PASV Mode Specifies that the program will work in PASV mode. 
 

Use Firewall Clear this option to enable the Firewall button. 
 

 
¾ 

1 
2 
3 
4 
5 

To specify Firewall parameters: 

Open the Connect dialog box. 
Select Use Firewall. The Firewall button is enabled. 
Click Firewall. The Firewall dialog box appears. 
Enter required parameters and select a firewall type. 
Click OK. 

 
The following parameters are displayed: 
 
Host Name The computer that you want to act as a security guard prior to 

granting access to a remote computer. 
 

User Name The account of the computer that you want to perform the 
security check. 
 

Password Enter the password that you were assigned for the computer 
that performs the security check. 
 

Port A number that identifies an Internet application, which 
performs the security check. Default port is 21. 
 

Type Firewall type. If you do not know which type of firewall you 
have, choose the default (the most popular) or contact your 
firewall manufacturer to verify the type. 
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Working with Connection Profiles 

If you frequently connect to a specific remote computer, you can create a Connection Profile for 
this computer to use again for other PowerTerm FTP Client sessions. This profile contains the 
connection parameters for the specific FTP site, for example, the host name, user name and 
password. The connection profile you create is displayed in the Connection List, which is saved 
in the current Configuration File along with the configuration settings. PowerTerm FTP Client 
enables you to modify, delete, and reset (clear) the parameters of a Connection Profile. You can 
also use Reset to introduce new parameters and create a new Connection Profile. 
 

¾ 

1 
2 
3 

¾ 

1 
2 
3 

¾ 

1 
2 

¾ 

1 

2 

To create a connection profile: 

Enter parameters in the Connect dialog box. 
Type a profile name in the Description field. 
Click Add. The connection profile is created and displayed in the Connection List. 

 
To modify a profile: 

Select the desired Connection Profile from the Connection List. 
Modify the parameters as required. 
Click Modify. The profile is modified. 

 
To delete a profile: 

Select the desired Connection Profile from the Connection List. 
Click Delete. The profile is deleted. 

 
To reset (clear) a connection profile: 

Open the Connect dialog box. The last parameters specified are displayed. 
Or  
Select the desired Connection Profile from the Connection List. 
Click Reset. Parameters are cleared. 
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Connecting to an FTP Site 

Once you have defined your connection parameters or selected a connection profile, you are 
ready to connect to an FTP site. After the connection is established, the PowerTerm FTP Client 
window displays directories and files of the remote computer in the lower part of the window. A 
log window is also displayed if you have selected the Open Log Window option in the FTP-
Preferences dialog box. 
 

¾ 

1 
2 
3 

• 

To connect to an FTP site: 

Display the Connect dialog box. 
Specify connection parameters or select a Connection Profile from the Connection List. 
Click Connect. 
Or, 

Double-click a Connection Profile in the Connection List. 
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Using the FTP-Log Window 

The PowerTerm FTP Client enables you to open a temporary log window to display messages 
exchanged (connection information) by the PowerTerm FTP Client and remote server. You can 
either automatically display the Log-FTP window every time that you connect to an FTP site, or 
you can open it for a specific session. 
 

¾ 

1 
2 

¾ 

1 
2 
3 
4 

¾ 

1 

2 

¾ 

1 
2 

3 

¾ 

• 

¾ 

• 

To automatically display connection information for all sessions: 

Select Settings | Options. The FTP-Preferences dialog box appears. 
Select Open Log Window and click OK. The Log-FTP window will automatically open 
and display connection information each time you connect to an FTP site. 

 
To display connection information for a specific session: 

Select Services | Log. The Log-FTP window opens with no information. 
Click Connect in the PowerTerm FTP Client window. The Connect dialog box appears. 
Enter connection parameters. 
Click Connect. The Log-FTP window displays each step performed by PowerTerm FTP 
Client in the connection process. 

 
To stop/start displaying connection information: 

Click the Stop button to stop displaying connection information. The button toggles to 
Start. 
Click Start to continue displaying connection information. The button toggles to Stop. 

 
To save the connection information to a log file: 

Click the Save button. The Save As dialog box appears. 
Select the directory and specify the name of the file to which you want to save the 
connection information. 
Click Save. The file is saved with the .log extension. 

 
To clear the Log-FTP window: 

Click Clear. All connection information displayed is cleared. 
 
To close the Log-FTP window: 

Click Close to exit. 
 
The following options are available in the Log-FTP window: 
 
Stop Stops displaying connection information. This button toggles to 

Start. 
 

Save Saves the connection information in a log file. 
 

Clear Clears the Log-FTP window. 
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Close Closes the Log-FTP window. 
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Working with Local and Remote 
Directories and Files 

The PowerTerm FTP Client enables you to manipulate the directories and files in both your own 
computer and the remote computer. It also provides options to select, create, and remove 
directories and files as well as rename and view the contents of a file in the format that it was 
created. The ability to refresh the display of your local and remote directory and file structures is 
also featured. 

N
 

OTE Some FTP sites may restrict access to certain functions, for example, 
removing a directory or deleting a file. 

 
 

¾ 

1 
2 

1 
2 

• 

¾ 

1 
2 
3 

¾ 

1 
2 
3 

¾ 

1 
2 

• 

¾ 

1 

To select a directory: 

Select the required directory using standard windowing selection conventions. 
Click Change. 
Or 
Type the name of the required directory in the Directory field. 
Press Enter. 
Or 

Double-click the required directory. 
The selected directory and its files are displayed. 
 
To create a directory: 

Double-click the required drive (local or remote as desired). 
Type the name of the new directory in the Directory field. 
Click Create. The new directory is created and displayed in the local or remote directory 
list as specified. 

 
To remove a directory: 

Select the required drive (local or remote as desired). 
Select the directory that you want to remove. 
Click Remove. The directory is removed from the local or remote directory list as 
specified. 

 
To view a file: 

Select the file that you want to view. 
Click View. 
Or 

Double-click the required file. 
The file is displayed in the format in which it was created. For example, a file with a .doc 
extension is opened in Word and a file with a .txt extension is opened in Notepad. 
 
To delete a file: 

Select the file that you want to delete. 
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Click Delete. The selected file is deleted from the list. 2 

¾ 

1 
2 
3 
4 

¾ 

• 

 
To rename a file: 

Select the file that you want to rename. 
Click Rename. The Rename dialog box appears. 
Type the new file name and extension. 
Click OK. The file is displayed in the file list with the new name. 

N
 

OTE You can use standard windowing conventions like Shift and Control, to 
select multiple files. 
 

 
To refresh the directory display: 

Select Services | Refresh. The information displayed in the PowerTerm FTP Client window 
is refreshed. All changes that you have made to directories or files will be displayed. 
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Transferring Files 

The PowerTerm FTP Client enables you to download and upload files between your computer 
and an FTP site. Files can be copied to a directory or appended to an existing file. Most menu 
options and toolbar buttons are inactive during the transfer of files, however, you can still 
perform informative operations, for example viewing directory and file information and accessing 
online help. You can minimize the PowerTerm FTP Client window while file transfer is in 
progress. 

N
 

OTE You can use standard windowing conventions like Shift and Control, to 
select multiple files. 
 

 
¾ 

1 
2 
3 
4 

1 
2 
3 
4 

¾ 

1 
2 
3 
4 

1 
2 
3 
4 

To download a file from an FTP site: 

The name of the file, which is to receive the downloaded file, must be specified. If the receiving 
file does not exist, the PowerTerm FTP Client will create it for you. The downloaded file is 
copied into your directory under this file name. If this file already exists, the new file will 
overwrite it. 
 
Copying a file: 

Select the target local directory. 
Select the file to download from the FTP site. 
Select Copy. 
Click the left arrow button. The FTP Transfer dialog box graphically displays the 
progress of downloading the selected file. 

 
Appending a file: 

Select the target local file. 
Select the file to download from the FTP site. 
Select Append. 
Click the left arrow button. The FTP Transfer dialog box graphically displays the 
progress of downloading the selected file. 

 
To upload a file to an FTP site: 

Copy a file: 
Select the target remote directory. 
Select the file to upload from your computer. 
Select Copy. 
Click the right arrow button. The FTP Transfer dialog box graphically displays the 
progress of uploading the selected file. 

 
Appending a file: 

Select the target remote file. 
Select the file to upload from your computer. 
Select Append. 
Click the right arrow button. The FTP Transfer dialog box graphically displays the 
progress of uploading the selected file. 
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Automatic File Transfer 

The PowerTerm FTP Client enables you to automate connection and transfer options by creating 
a PowerTerm FTP Client shortcut, which specifies the necessary parameters to perform these 
operations. Once you have created the shortcut, you activate it by double-clicking its icon. The 
following parameters can be specified: 
 

Connection parameters for connecting to an FTP site. They include the host site, user name, 
and password. 

• 

• 

¾ 

1 

2 

3 

4 
5 

File transfer parameters for connecting to an FTP site and transferring files to or from your 
computer. The transfer parameters include the location of the PowerTerm FTP Client and the 
host site, file transfer direction, and file path of the local or remote file that you want to 
receive or send. You can also use file transfer conventions to transfer all file, or all files of a 
single type, to and from a directory. 

I
 

MPORTANT The PowerTerm FTP Client uses a set sequence of parameters to 
transfer files. This sequence cannot be modified. 
 

N
 

OTE The following procedures describe one way to create a shortcut. Consult 
your windows documentation for a description of other methods. 

 
 

To create a shortcut: 

Locate the file ftpc32.exe on your computer. It resides in the PowerTerm installation 
folder. 
Right-click and select Create Shortcut. The shortcut to ftpc32.exe appears in the current 
folder. 
Right-click the shortcut and select Properties. The Shortcut to ftpc32.exe Properties 
dialog box appears. 
Enter, in the Target field, the required parameters after the target file path. 
Click OK. The next time that you open PowerTerm FTP Client, it will open with the 
parameters defined. 

Example of Connection Parameters (P): 

 

Example of File Transfer Parameters (P): 

 
 
The parameters are: 
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Parameter 1 Host site name 
 

Parameter 2 User name 
 

Parameter 3 Password 
 

Parameter 4 File transfer direction.  
• 
• 

• 
• 

¾ 

• 

¾ 

Get for downloading. 
Put for uploading. 

 
Parameter 5 File transfer mode.  

Binary 
Ascii. 

 
Parameter 6 Path and name of the local or remote file that you want to 

transfer, according to the file transfer direction specified in 
Parameter 4. 
 

Parameter 7 Path and name of the local or remote file that receives the 
transferred file, according to the file transfer direction specified 
in Parameter 4. 
 

I
 

MPORTANT The PowerTerm FTP Client will display an error message telling you of 
any missing parameters. You must enter “ “ as the password parameter rather 
than leaving it empty. 

 

File Transfer Conventions 

PowerTerm FTP Client enables you to use wildcards, and combinations of them, in Parameter 6 
and 7 to transfer groups of file. 
 
The symbols used for wildcards are: 
 
* Any character combination. 

 
? Any single character. 

 
 

To transfer all files with the same extension: 

Type * and the file extension, to upload or download all files of this type in a directory. 
 

Example: 
All files with the .cpp extension will be copied to /usr/pub/ericom. 
C:\*.cpp /usr/pub/ericom/ 

 
To transfer all files of one type and save them with a different 
extension: 
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Type * and the extension that you want to give to the transferred files. • 

¾ 

• 

¾ 

• 

 
Example: 
All files with the .cpp extension will be copied to the folder /usr/pub/ericom receiving the 
same name, but with a .txt extension 
C:\*.cpp /usr/pub/ericom/*.txt 

 
To append all files of one type to a specific file: 

Type the name of the file to which you want to append the transferred files. 
 

Example: 
All files with the .cpp extension will be appended to the file /usr/pub/ericom/aaa.txt. 
C:\*.cpp /usr/pub/ericom/aaa.txt 

 
To transfer a file to another unknown file: 

Type ? for the unknown letter in the file name. 
 

Example: 
The file aaa.log will be copied to the file /usr/pub/ericom/babcc.txt 
C:\aaa.log /usr/pub/ericom/b?b*.txt 

   
 



 
  

114

Disconnecting and Exiting PowerTerm 
FTP Client 

Before you exit the PowerTerm FTP Client, you need to disconnect from the current FTP site. 
 
Changes to the preferences are either saved automatically when you exit the PowerTerm FTP 
Client, if you selected Save Settings on Exit, or you are prompted to save them. 
 

¾ 

• 

¾ 

• 

To disconnect from an FTP site: 

Click Disconnect. 
 
To exit the PowerTerm FTP Client: 

Select File | Exit. 
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Troubleshooting the PowerTerm FTP 
Client 

If you have any difficulties with PowerTerm FTP Client, refer to the following checklist: 
 
Connection cannot be 
established.  
 

• 

• 

• 

• 

• 

Ensure that the remote system provides an FTP server, 
which is running. 
Ensure you have entered the system type correctly. Select 
Auto if you do not now the system type to which you are 
connecting. 

 
PowerTerm FTP Client 
reports a login failure. 
 

Ensure that the User name and Password were entered 
correctly. 

Files cannot be transferred 
or received. 

Ensure that the correct transfer type (Binary or Ascii) is 
selected. Transferring a file in the incorrect mode may 
corrupt that file. Select Binary, unless you transfer text files 
to or from a UNIX FTP server. 
Ensure that you have the necessary permission for specific 
operations, like write access to a directory. 
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